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Учебное пособие ориентировано на изучение работы в системе 

автоматизированного проектирования SolidWorks, ее использовании в конструкторско-

технологическом проектировании приборов. Содержит описание пяти лабораторных 

работ, посвященных общим принципам создания твердотельных моделей деталей и 

сборок в SolidWorks 2013. 

Предназначены для студентов специальностей 161100.62 – Системы управления 

движением и навигация, 220400.62 – Управление в технических системах при 

выполнении лабораторных работ по дисциплинам «3D моделирование и 

проектирование приборов», «Автоматизированное проектирование систем и средств 

управления». Могут быть рекомендованы студентам машиностроительных и 

приборостроительных специальностей для быстрого освоения системы SolidWorks. 

 

 

 

  



 

Лабораторная работа № 1.  

 

Знакомство с SolidWorks.  

Общие принципы трехмерного проектирования изделий в SolidWorks 

 

Цель работы – изучение общих принципов построения трехмерных моделей 

деталей и сборок в системе автоматизированного проектирования SolidWorks. 

 

Методические указания 

 

Проектирование изделия в SolidWorks состоит из нескольких этапов: выбор 

конструктивной плоскости для создания двумерного эскиза, преобразование эскиза в 

твердотельный элемент, формирование детали из различных элементов, компоновка 

созданных деталей в сборку. При этом гибкие инструменты конструктора 

SolidWorks позволяют изменять значения любого размера, накладывать взаимосвязи 

на взаимное расположение объектов в течение всего процесса проектирования. 

Процесс создания трехмерных моделей основан на принципах добавления и снятия 

материала, аналогичных методам реальных технологических процессов. 

 

Особенности интерфейса SolidWorks 
 

Интерфейс SolidWorks соответствует привычному графическому интерфейсу 

программ семейства Windows Microsoft. Стандартные функции Windows обеспечивают 

работу с файлами (создание, открытие, сохранение и др.). Печать эскизов, 3D моделей 

с экрана и чертежей в SolidWorks осуществляется на любое устройство графического 

вывода (плоттер, принтер), установленное в операционной системе. 

Проектирование в SolidWorks включает создание объемных моделей деталей и 

сборок с возможностью генерировать на их основе рабочие чертежи. Создание нового 

документа в SolidWorks сопровождается выбором шаблона документа: Деталь, 

Сборка или Чертеж. В случае выбора шаблонов Деталь или Сборка графическая 

область представляет собой трехмерное пространство. 

Основными элементами интерфейса SolidWorks являются: меню,  панели 

инструментов, область построения, строка состояния (рис. 1.1). Для наглядного 

представления процесса проектирования в SolidWorks существует Дерево 

конструирования или Дерево построения (Feature Manager). Оно реализовано в 

стиле традиционного Проводника Windows, обычно располагается в левой части 

рабочего окна SolidWorks и представляет собой последовательность конструктивных 

элементов, образующих деталь, а также дополнительные элементы построения (оси, 

плоскости). Дерево построения содержит полную информацию о трехмерном объекте 

и динамически связано с областью построения. В режиме сборки Дерево построения 

отображает список деталей, входящих в сборку, а также необходимые сопряжения 

деталей и сборок (рис. 1.1). 

 

 



 

 

 
Рисунок 1.1. Элементы интерфейса SolidWorks 

Дерево построения (Feature manager) 
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Основными функциями Дерева конструирования (FeatureManager) являются: 

– выбор элементов по имени (по нажатию левой кнопки мыши); 

– определение и изменение последовательности, в которой создаются элементы; 

– отображение размеров элемента, которое можно выполнить, дважды нажав на 

имя элемента; 

– отображение и гашение элементов детали и компонентов сборки. 

 

При построении новой трехмерной модели детали в Дереве построения по 

умолчанию присутствуют следующие графические элементы (рис.1.2): 

– исходная точка с нулевыми начальными координатами; 

– три взаимно перпендикулярные плоскости: Спереди, Сверху, Справа. 

Панель инструментов является настраиваемым элементом интерфейса. 

Пользователь имеет возможность устанавливать расположение панелей инструментов, 

их отображение в зависимости от типа документа. 

Диспетчер команд – это контекстная панель инструментов, которая обновляется 

автоматически в зависимости от панели инструментов, к которой требуется доступ. 

При построении детали Диспетчер команд по умолчанию содержит панели 

инструментов: Элементы и Эскиз, в режиме сборки – панели инструментов Сборка и 

Эскиз. 

Быстрая настройка Панелей инструментов и Диспетчера команд производится 

при нажатии правой кнопки мыши на границе окна соответствующей панели. 

Верхнее меню содержит команды SolidWorks в полном объеме (Рис. 1.2). Верхнее 

меню появляется на экране при наведении курсора мыши на надпись SolidWorks в 

левом верхнем углу экрана. При отсутствии команды на панели инструментов ее 

всегда можно найти через верхнее меню.  

 

 
Рисунок 1.2. Верхнее меню SolidWorks.  

 

В строке состояния в нижней части окна SolidWorks представлена информация, 

связанная с выполняемой функцией. 

Действие манипулятора мыши в SolidWorks соответствует стандартным функциям 

операционных систем семейства Windows Microsoft. 

Выбор объектов (элементов в дереве построения, поверхностей твердотельной 

модели в области построения, выбор объектов в плоском эскизе) осуществляется при 

нажатии левой кнопки мыши. Нажатие правой кнопки мыши соответствует запуску 

всплывающего меню объекта. 

Общий принцип создания твердотельных объектов выражается приведенной 

последовательностью: 

1. Выбор плоскости для построения Эскиза. 

2. Построение объектов плоского эскиза, простановка размеров, определение 

взаимосвязей. 



3. Выполнение действия над плоским эскизом, придание толщины плоским 

объектам эскиза (вытягивание, поворот и т.д.). 

В режиме конструирования детали выполним построение простого 

цилиндрического элемента методом вытянутой бобышки, и на примере рассмотрим 

основные инструменты SolidWorks. 

 

Создание цилиндрического твердотельного элемента 

 

Для построения модели трехмерного цилиндра следует выполнить следующие 

действия: 

1. Начать новый документ – деталь SolidWorks. 

2. На панели инструментов Элементы нажать кнопку Вытянутая бобышка/ 

основание. При этом будет активизирована команда создания твердотельного 

элемента методом вытянутой бобышки (Рис. 1.3). 

 
Рисунок 1.3. Графическая область при создании твердотельного элемента командой 

Вытянутая бобышка/ основание. 

 

3. Система предложит выбрать одну из трех начальных плоскостей: Спереди, 

Сверху, Справа для построения Эскиза будущего трехмерного элемента. 

4. Выбрать плоскость Спереди (выбор осуществляется по надписи наименования 

плоскости). При этом изображение на дисплее изменится таким образом, что 

плоскость Спереди будет обращена на пользователя, перпендикулярно направлению 

его взгляда. Выбор плоскости для построения эскиза может быть выполнен до 

активизации команды создания твердотельного элемента. 

5. На панели инструментов Эскиз инструментом Окружность построить 

окружность произвольным радиусом с центром в Исходной точке с нулевыми 

координатами. 

 



6. Нажать кнопку Автоматическое нанесение размеров и, выбрав дугу 

окружности, изменить размер в появившемся окне на значение 100 мм. 

7. Нажать значок  Выход из эскиза в окне Угол принятия решения, 

чтобы завершить эскиз, при этом система автоматически предложит выбор параметров 

создаваемого элемента Вытянуть в окне Менеджера свойств (левая часть экрана), а 

также в графической области будет отображаться предварительный вид создаваемого 

трехмерного элемента (рис. 1.4). 

8. В разделе Направление 1 окна Менеджера свойств установить параметр 

Глубина равным 100 мм (рис. 1.4). 

9. Нажать Enter, или Ok, либо значок  принятия элемента в окне Угол 

(правый верхний угол экрана) для выбора в графической области системы SolidWorks. 

10. Сохранить деталь под именем Деталь1.sldprt. 

 

В результате была построена трехмерная модель цилиндра с диаметром 

основания 100 мм и высотой 100 мм. Построенный элемент отображается в 

графической части системы и динамически связан с объектом в Дереве построения 

под наименованием Вытянуть 1. 

 

Изменение ориентации вида 

 

Для изменения ориентации вида существует панель инструментов Ориентация 

видов (рис. 1.5). Она позволяет выбрать один из шести стандартных видов: Спереди, 

Сзади, Сверху, Снизу, Справа, Слева, а также изометрические проекции 

Изометрия, Диметрия, Триметрия. Ориентации видов соответствуют расположению 

трех основных начальных плоскостей: Спереди, Сверху, Справа. При выборе вида 

Спереди плоскость экрана монитора соответствует плоскости Спереди. 

Также панель Ориентация видов позволяет установить вид Перпендикулярно 

направлению взгляда наблюдателя. В этом случае предварительно необходимо 

выбрать плоскую грань или плоскость, либо цилиндрическую или коническую грань. 

Также может быть задано количество видов в графической области: Один вид, 

Два вида или Четыре вида. 

 

 

 

 

 



 
Рисунок 1.4. Определение параметров элемента Вытянуть.  
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Рисунок 1.5. Панель Ориентация видов на панели инструментов Вид. 

 

Изменение масштаба, вращение и перемещение вида 

 

Команды изменение масштаба, вращения и перемещения вида содержатся на 

панели инструментов Вид (см. рис. 1.5). Изменение масштаба вида выполняется двумя 

основными командами: 

– Увеличить элемент вида            

– Изменить в размер экрана         

 

Команда Изменить в размер экрана изменяет масштаб вида так, чтобы модель, 

сборка или чертежный лист были видны полностью. Команда Увеличить элемент 

вида может быть успешно заменена изменением масштаба вида с помощью колеса 

«скрола» мыши. Поворот колеса мыши назад соответствует увеличению масштаба, 

поворот колеса мыши вперед – уменьшению масштаба вида. Во время вращения 

указатель мыши является центром изменения масштаба. 

Вращение вида может быть выполнено по команде Вращать вид либо при 

нажатии средней кнопки мыши или колеса «скрола». В последнем случае для поворота 

вида необходимо нажать «скрол» и, не отпуская его, перемещать указатель мыши. 

Перемещение детали выполняется по команде Перемещать вид. Перемещение 

вида может выполняться также аналогично повороту вида (перемещением мыши с 

нажатым колесом прокрутки) при нажатой клавише Ctrl. 

Наиболее эффективное изменение параметров вида модели может быть 

достигнуто в случае совместного использования манипулятора «мыши» – его колеса 

прокрутки «скрола», а также кнопок панели инструментов Вид. 

  



Пример построения трехмерной детали. 

 

Задание. Построить модель детали, изображенной на рис. 1.6 

 
Рис.1.6. Деталь 

 

Указания к выполнению детали  

1. Выполнить анализ заданной детали.  

Анализ рекомендуется производить с целью оптимизации количества построений 

и правильного определения исходной плоскости для построения основания и методов 

построения. На рис. 1.7 представлен один из возможных вариантов построения детали, 

где каждый последующий шаг дополняет деталь. 

 
Рис. 1.7. Этапы построения детали. 

 

2. Создать документ SW “Деталь”. Вызвать последовательно функции: “Файл”, 

“Создать”, “ Деталь”, “ОК”.  

3. Создать основание детали.  

3.1. Выбрать в Дереве конструирования, путем наведения курсора и нажатия 

левой кнопки мыши, плоскость “Cверху” (рис. 1.9). 



 
Рис. 1.8. Выбор плоскости для построения детали. 

 

3.2.Ориентировать выбранную плоскость в направлении “Перпендикулярно” (рис. 

1.9), выбрав кнопку  в панели Ориентация видов. 

 
Рис. 1.9. Перпендикулярная ориентация плоскости проектирования. 

 

3.3.Активизировать функцию “Прямоугольник” в панели инструментов Эскиз и 

вычертить прямоугольник в эскизе, как показано на рис. 1.10. 

 

 

 

 

 

 



 
Рис. 1.10. Отображение прямоугольника 

 

 

3.4. Нажать левой кнопкой мыши на кнопку  для деактивизации функции 

“Прямоугольник”.  

3.6. Нажать левой кнопкой мыши в любом свободном месте окна чертежа. При 

этом прямоугольник окрасится в синий цвет, что говорит о неопределенности эскиза 

(отсутствуют взаимосвязи между элементами эскиза и их размеры).  

3.7. Удалить одну сторону прямоугольника, нажав на нее левой кнопкой мыши и 

далее удалить выбранный элемент кнопкой Delete на клавиатуре. На рис. 1.11 показан 

результат выполненной команды Delete. 



 
Рис.1.11. Результирующий эскиз после удаления одной стороны прямоугольника 

 

3.7. Нарисовать дугу. Активизировать функцию “Дуга через три точки“ . 

Первую и вторую точки выбрать нажатием левой кнопки мыши, как показано на рис. 

1.12, далее двигать курсор мыши право до тех пор, пока центр дуги не окажется на 

всплывающей пунктирной линии, соединяющей первую и вторую точки, и нажать на 

левую кнопку мыши (рис. 1.12). 

 
Рис. 12. Создание дуги 

 



3.8. Выполнить взаимосвязь элементов эскиза с исходной точкой. 

Последовательность выполняемых действий такая. Активизировать функцию 

“Добавить взаимосвязь”: 

 
Выбрать “Центр дуги” и “Исходную точку”. На рис. 1.13 приведен пример 

установления взаимосвязи “Совпадение”. Установить взаимосвязь “Совпадение”, 

применить ее. 

 
Рис. 1.13а. Установление взаимосвязи “Совпадение”: выбор элементов 

 

 
Рис. 1.13б. Установление взаимосвязи “Совпадение”: результат 

 



3.9. Установить размеры в эскизе.  

3.9.1. Активизировать функцию “Автоматическое нанесение размеров” . Нажать 

первый раз левой кнопкой мыши на любую точку на дуге, второе нажатие произвести 

в свободном месте окна чертежа, в появившемся диалоговом окне указать требуемое 

значение диаметра окружности (40 мм) (рис. 1.14).  

 
Рис. 1.14. Нанесение размера дуги 

 

В диалоговом окне “Изменить” указано действительное значение отображенного 

элемента, которое можно изменять.  

3.9.2. Активизировать функцию “Автоматическое нанесение размеров”.  

Нажать левой кнопкой мыши на любую точку вертикальной линии эскиза, нажать 

левой кнопкой мыши в любом месте чертежного окна, установить требуемый размер 

линии (100 мм). Результат выполнения указанных действий проиллюстрирован на рис. 

1.15. 



 
Рис. 1.15.  

 

3.10.Создать твердотельный элемент.  

3.11. Активизировать функцию “Вытянутая бобышка/основание” в панели 

инструментов “Элементы”. Установить требуемое значение вытягивания (30 мм). 

Применить функцию. На рис. 1.16 представлен фрагмент работы программы при 

создании элемента “Вытянутая бобышка”. 

 
Рис. 1.16. Создание элемента “Вытянутая бобышка” 

 

4. Создать цилиндр.  

4.1. Нажатием левой кнопки мыши активизировать верхнюю грань основания. 

Результат указанного действия представлен на рис. 1.17.  

  



 
Рис. 1.17. Выбор плоскости проектирования второго элемента 

4.2. Вызвать команду “Создать эскиз” , вызвать функцию Перпендикулярно” 

для того чтобы ориентировать плоскость эскиза. 

4.3. Активизировать функцию “Окружность” .  

4.4. Установить курсор в исходную точку, нажать левую кнопку мыши, 

отодвинуть курсор мыши от установленного центра, нажать повторно левую кнопку 

мыши для обозначения одной из точек желаемой окружности.  

4.5. Установить размер окружности. Активизировать функцию “Автоматическое 

нанесение размеров”. Нажать левой кнопкой мыши на любую точку окружности, 

вывести размерную линию путем перетаскивания курсора мыши по окну чертежа, 

повторно нажать на левую кнопку мыши в месте, где желаете расположить надпись 

размера, установить в диалоговом окне требуемый размер окружности (40 мм). 

Результат выполнения указанных действий представлен на рис. 1.18. 

 
Рис.18. Элемент окружность. 



4.6. Вытянуть окружность на 30 мм с помощью функции “Вытянутая 

бобышка/основание”.  

5. Построить квадратный вырез.  

5.1. Нажать левую кнопки мыши, активизировать верхнюю грань основания. 

Нажать функцию “Создать эскиз”, ориентировать плоскость эскиза 

“Перпендикулярно” , как указано на рис. 1.19. 

 
Рис. 1.19.Выбор и ориентация новой плоскости проектирования 

 

5.2. Активизировать функцию “Прямоугольник” , вычертить прямоугольник, 

установить требуемые размеры квадрата и его расположения относительно 

существующих кромок детали, как показано на рис. 1.20. 

 
Рис. 1.20. Установление размеров 

 

 



5.3. Активизировать функцию “Вытянутый вырез” и установить значение 20 мм. 

Результат действия указанной функций представлен на рис. 1.21. 

 

 
Рис. 1.21. Создание вытянутого выреза.  

 

6. Создать уклон.  

Активизировать функцию “Уклон” . В диалоговом окне установить 

требуемые параметры в следующем порядке:  

- в графе “Угол уклона” – 15 градусов;  

- в графе “Нейтральная плоскость” (если графа белая, то нажатием левой кнопки 

мыши на диалоговом окне графы она активизируется и станет розового цвета) 

прописать дно квадратного выреза путем нажатия на него;  

- в диалоговом окне “Грани под уклон” прописать боковые грани квадратного 

выреза путем последовательного нажатия на них левой кнопкой мыши. С целью 

удобства выбора граней под уклон рекомендуется вращать деталь. На рис. 1.22 

приведен пример установления значений элементов детали для создания элемента 

“Уклон”. 

7. Создать скругление.  

Активизировать функцию “Скругление” . В диалоговом окне функции 

указать значение радиуса скругления (10 мм). Нажать на детали кромку, которую 

необходимо скруглить. На рис. 1.23-1.24 приведен результат выполнения функции 

“Скругление”.  

 



 
Рис. 1.22. Создание уклона 

 

 
Рис. 1.23. Создание скругления.  

 

 

 

 

 

 

 

 

 

Нейтральная плоскость 

Грани под уклон 



 
Рис. 1.24. Результат операции скругления.  

 

8. Создать вырез. 

8.1. Выбрать плоскую грань основания (для удобства деталь рекомендуется 

вращать), перпендикулярную направлению выреза (рис. 1.25). Нажатием левой кнопки 

мыши активизировать ее, вызвать функцию “Создать эскиз”. 

 
Рис. 1.25. Выбор плоскости проектирования 

 



8.2. Ориентировать плоскость эскиза “Перпендикулярно” .  

8.3. Выбрать элемент эскиза “Многоугольник” (“Инструменты” – “Объекты 

эскиза” – “Многоугольник”). Нажать левой кнопкой мыши на место желаемого 

положения центра многоугольника путем передвижения курсора по окну чертежа. По 

активному изображению многоугольника выбрать его желаемый размер и ориентацию 

и повторно нажать левую кнопку мыши для указания положения одной из вершин 

многоугольника. (Указание числа граней производят в диалоговом окне “Настройки” 

функции “Многоугольник”).  

8.4. Для указанного объекта необходимо выполнить взаимосвязь элементов 

многоугольника для определения его ориентации в плоскости. Для этого необходимо 

активизировать функцию “Добавить взаимосвязь:, нажатием левой кнопки мыши на 

одну из кромок шестиугольника установить взаимосвязь “Вертикальный”, как указано 

на рис. 1.26. 

 

 
Рис. 1.26. Установление взаимосвязи “Вертикальный” для одной из сторон 

многоугольника. 

 

8.5. Установить размер кромки многоугольника (10 мм), как указано на рис. 1.27.  

8.6. Установить размер положения центра многоугольника (рис. 1.27).  

8.7. Установить взаимосвязь “Вертикальный” между центром многоугольника и 

исходной точкой. Результат произведенной взаимосвязи представлен на рис. 1.27. 

 

  



 

 
Рис. 1.27. Размеры многоугольника 

 

 

8.8. Активизировать функцию “Вытянутый вырез” и установить значение 150 мм 

по направлению внутрь детали. Результат описанных действий приведен на рис. 1.28. 

 

 
Рис. 1.28. Результат создания детали. 

 

  



Лабораторная работа № 2.  

 

Построение плоских эскизов в SolidWorks 

 

Цель работы – изучение методов построения плоских объектов эскиза, способов 

задания размеров и определения взаимосвязей объектов в системе 

автоматизированного проектирования SolidWorks. 

 

Методические указания 

 

Элементы SolidWorks основываются на построении двумерных эскизов. Эскиз 

состоит из некоторого числа простейших геометрических объектов: отрезков, 

сплайнов, дуг и т.п., соединенных между собой. Построение эскизов основано на 

применении различного рода инструментов рисования, создания взаимосвязей и 

задания размеров. 

 

Определение плоскости для построения эскиза 

 

 
Рис. 2.1. Основные плоскости SolidWorks:Спереди, Сверху, Справа 

 

При создании новой детали или сборки трем основным плоскостям проекции в 

начертательной геометрии: горизонтальной, вертикальной и профильной в 

SolidWorks определяются три соответствующих плоскости: Спереди, Сверху, Справа 

(рис. 2.1). Ориентация направления плоскостей выполняется по команде Ориентация 

видов. Если выбран параметр Спереди в окне ориентация, то направление взгляда 

пользователя на экран будет перпендикулярно виду Спереди. 

Плоский эскиз можно создавать: 

– на любой плоскости по умолчанию (Спереди, Сверху или Справа); 

– созданной инструментами Справочной геометрии плоскости; 

– плоской грани твердотельного объекта. 



В SolidWorks существует возможность создавать трехмерные эскизы. 

Графические объекты (трехмерные линии, сплайны, точки) в таких эскизах 

располагаются в трехмерном пространстве и не связаны с определенными 

плоскостями эскизов. 

 

Работа в режиме редактирования эскиза 
 

Для построения двухмерного эскиза следует выполнить команду верхнего меню 

Вставка >> Эскиз либо нажать кнопку Эскиз  на панели инструментов Эскиз: 

 
Плоскость для построения эскиза может быть выбрана как до, так и после 

активации команды. 

Для перехода в режим редактирования уже существующего эскиза следует 

выделить в Дереве конструирования необходимый объект, запустить всплывающее 

меню (нажатием правой кнопки мыши), вызвать команду Редактировать эскиз (рис. 

2.2, а). 

 
Рис. 2.2.а Переход в режим редактирования эскиза – выбор команды 



 
Рис. 2.2.б Переход в режим редактирования эскиза – результат 

 

Основным признаком режима редактирования эскиза является характерный знак 

в окне Угол для выбора графической области построения (см. рис. 2.2, б). 

Для выхода из режима редактирования эскиза следует выполнить одну из команд 

(рис. 2.3): Выход из эскиза, Перестроить либо Отмена (без сохранения изменений) в 

окне Угол для выбора. 

 

Элементы формирования 

 

При построении плоских объектов эскиза (линий, дуг, многоугольников и т.п.) 

используются так называемые Элементы формирования: линии формирования, 

указатели, привязки эскиза и взаимосвязи. Элементы формирования динамически 

показывают, как элементы эскиза влияют друг на друга. 

Линии формирования – это пунктирные линии, которые появляются по мере 

создания эскиза. Когда указатель приближается к подсвечиваемым меткам (вершинам, 

средним точкам и т.п.), линии формирования используются в качестве ориентира в 

зависимости от существующих объектов эскиза (рис. 2.4). 

При построении объектов Вид указателя меняется в зависимости от выбранного 

инструмента рисования (дуга, окружность, линия), а также в случае, если указатель 

находится на геометрической взаимосвязи (пересечения, точки) либо на размере. Если 

при построении указатель отображает взаимосвязь, она автоматически добавляется к 

объекту 

Угол для выбора 



 
Рис. 2.3. Команда выхода из режима редактирования эскиза. 

 

Выход из эскиза 

Отмена 

Перестроить эскиз 



 

 
Рис. 2.4. Элементы формирования объектов эскиза 

 

Привязки эскиза существуют по умолчанию. Во время рисования отображаются 

значки привязок эскизов. 

Кроме Привязок эскиза можно отобразить значки, которые представляют 

Взаимосвязи между объектами эскиза. Во время рисования объектов отображают 

значки, представляющие Привязки эскиза, как только объект эскиза построен, 

отобразятся Взаимосвязи 

 

Объекты построения плоского эскиза 
 

Объекты построения эскиза расположены на панели инструментов Эскиз либо 

могут быть активированы через верхнее меню по команде Инструменты >> Объекты 

эскиза. Все свойства объектов делятся на три группы: тип (линия, дуга, окружность, 

эллипс), взаимосвязи (горизонтальность, вертикальность) и геометрические параметры 

(координаты, длина, угол, диаметр). Свойства отображаются в Менеджере свойств 

при построении объектов. 

К основным плоским объектам, используемым при построении эскизов, в 

SolidWorks относятся: 

– линии; 

– прямоугольники; 

– окружности; 

– дуги; 

– многоугольники; 

– сложные кривые и фигуры (эллипсы, параболы, сплайны и др.). 

 

Существуют два режима рисования плоских объектов в эскизах: 

1. Режим «нажать-перетащить» – прорисовка объекта начинается при нажатии на 

первую точку и последующем ее перетаскивании, не отпуская кнопки мыши, и 

заканчивается, когда кнопку отпускают. 

2. Режим «нажать-нажать» – прорисовка объекта начинается и заканчивается при 

нажатии кнопки мыши, прорисовывается объект перемещением между двумя этими 

нажатиями. 

Наиболее универсальным и часто используемым элементом для рисования 

плоских объектов в SolidWorks является Линия. При использовании объекта Линия в 

режиме «нажать-нажать» создается цепочка сегментов – ломаная линия. Завершить 



построение линии возможно через всплывающее меню, активизировав команду 

Выбрать, либо нажав клавишу Esc на клавиатуре. 

Дополнительно в SolidWorks реализована возможность перехода от прямой 

ломаной линии к касательной дуге без выбора соответствующего инструмента. Для 

этого необходимо, начиная рисовать новый сегмент ломаной линии от конечной точки 

предыдущего отрезка, отвести указатель мыши в сторону, затем снова вернуться в 

конечную точку. При дальнейшем построении формируется динамическая касательная 

дуга (рис. 2.5). Автоматический переход от Линии к Касательной дуге выполняется 

также при нажатии на клавиатуре латинской А. 

 

 
Рис. 2.5. Автоматический переход от линии к касательной дуге 

 

Для построения дуги в SolidWorks может быть использован один из трех 

инструментов: 

1. Центр дуги – необходимо задать координаты центра и одной из крайних точек, 

а затем зафиксировать угол дуги (третья точка) (рис. 2.6, а). 

2. Касательная дуга – команда может применяться для конечной точки 

существующего объекта (рис. 2.6, б). После ее выполнения между объектами 

автоматически устанавливается взаимосвязь Касательность. 

3. Дуга через три точки – требует указания двух крайних точек дуги, а путем 

перемещения третьей устанавливается значение радиуса (рис. 2.6, в). 

 
Рис. 2.6. Методы построения дуг 

 

Для большого числа практических задач требуется построить плавную кривую 

линию, проходящую через заданные точки. Для этих целей используются сплайны. 

В SolidWorks сплайны являются основным инструментов построения сложной 

геометрии эскизов и применяются при разработке дизайн-проектов оригинальных 

корпусов. Также сплайны могут быть использованы как «аппроксимирующая кривая» 

в инженерных задачах, где траектория изменения геометрии задается по 

определенному математическому закону. 



В SolidWorks используется «С-сплайн», кривизна которого контролируется 

разбросом контрольных точек. На рис. 2.7 представлен фрагмент создания эскиза с 

применением команды “Сплайн”. 

 
 

Рис. 2.7. Построение сплайна 

 

“Осевая линия”. (Применяют как элемент справочной геометрии при построении 

тел вращения, симметричных элементов деталей, задании ориентации элементов 

детали. Построение осевой линии производят путем указания первой и конечной точек 

оси подобно созданию линии). 

“Точечный”. (Элемент “точка” устанавливается путем нажатия левой кнопки 

мыши при положении курсора в требуемом месте. В основном применяют как 

справочный элемент.) 

Построение окружностей, прямоугольников, многоугольников в эскизах 

соответствует большинству графических САПР для работы с двухмерной векторной 

графикой (AutoCad, KOMPAS). Подробное описание правил построения и работы с 

объектами эскиза содержится в справочной системе SolidWorks. 

 

Нанесение размеров в двухмерном эскизе 

 

Геометрические объекты, построенные в эскизе, должны быть определены в 

пространстве. В конечном итоге должны быть заданы координаты точек 

соответствующих объектов (линий, дуг, окружностей). В режиме Эскиза положение 

объектов описывается математически за счет нанесения управляющих размеров либо 

за счет наложения ограничений на расположение объектов. 

Каждому управляющему размеру в SolidWorks соответствует отдельная 

переменная. Определив объекту эскиза необходимый набор параметров, все 

построенные элементы (линии, дуги, окружности, сплайны) могут быть представлены 

в виде системы уравнений. Программа автоматически перестраивает объект в 

соответствии с заданным значением управляющего размера (все изменения 

отображаются в графической области). 

С помощью инструмента Автоматическое нанесение размеров на панели 

инструментов Эскиз можно нанести размеры для объектов эскиза. Для выполнения 

команды требуется изначально выделить один или два объекта (линии, точки, дуги, 

окружности) и определить положение размерной линии (рис. 2.8). Если линии 

расположены не параллельно, система самостоятельно определит угловой размер. 

Аналогично определяются диаметральный и радиальный размеры. 



 
Рис. 2.8. Простановка размеров объектов на плоском эскизе 

 

Размер может быть установлен как относительно существующего объекта эскиза, 

включая Исходную точку и вспомогательные осевые линии, так и относительно уже 

построенных трехмерных элементов и их эскизов. 

После того как выбраны объекты и установлено месторасположение размерной 

линии появится диалоговое окно Изменить. Введя новое значение в этом диалоговом 

окне, можно изменить размер (см. рис. 2.8). 

Следует отметить, что размерные линии управляющих размеров, нанесенные на 

эскизах, не являются обязательными размерными линиями будущего чертежа, хотя 

могут быть туда перенесены автоматически. Простановка размеров в Эскизе является 

параметризацией геометрических объектов, в то время как размеры на чертежах 

устанавливаются в соответствии с требованиями стандартов единой системы 

конструкторской документации (ЕСКД). 

 

Взаимосвязи 

 

Взаимосвязи представляют собой ограничения на расположения плоских 

объектов эскиза. Основной целью добавления взаимосвязей является уменьшение 

числа управляющих размеров. На рис. 2.9 показаны два варианта определения 

квадрата в эскизе, центр которого совпадает с Исходной точкой эскиза. 

В первом случае (рис. 2.9, а) было выполнено построение объекта 

Прямоугольник с последующим заданием необходимых размеров, включая размеры 

от сторон до Исходной точки (всего четыре размера). 

Во втором случае (рис. 2.9, б) кроме прямоугольника была построена его 

диагональ с помощью вспомогательной Осевой линии. Добавлено две взаимосвязи: 

Равенство смежных сторон прямоугольника и Средняя точка для диагонали 

прямоугольника и Исходной точки. Для полного определения квадрата достаточно 

задать один размер – длину стороны. 

Для добавления взаимосвязи следует активизировать команду Добавить 

взаимосвязь на панели инструментов Эскиз либо сразу выбрать необходимый объект 

или объекты эскиза (выбор нескольких объектов выполняется, удерживая клавишу 

Ctrl на клавиатуре). Система самостоятельно определяет допустимые взаимосвязи для 

выбранных объектов и предлагает выбрать одну из них. В окне Менеджер свойств 

следует нажать соответствующую пиктограмму (Совпадение, Горизонтальный, 

Зафиксированный и т.п.). 



Заданное относительное положение объектов не может быть изменено до тех пор, 

пока взаимосвязи не будут удалены. 

 

 
Рис. 2.9. Способы определения квадрата в эскизе 

 

Для удаления взаимосвязей необходимо выделить объект (линию или точку) и в 

списке Существующие взаимосвязи менеджера свойств (рис 2.10) удалить 

соответствующую взаимосвязь (клавишей Delete на клавиатуре). 

 
 

Рис. 2.10. Отображение существующих взаимосвязей объекта эскиза 

 

Большое количество взаимосвязей значительно затрудняет процесс исправление 

ошибок, так как для этого необходимо удалять лишние взаимосвязи. Чтобы не 

загромождать нарисованные объекты значками взаимосвязей, их рекомендуется 

отключить (верхнее меню Вид >> Взаимосвязи эскиза). Удалять взаимосвязи в этом 

случае возможно через команду Инструменты >> Взаимосвязи >> 

Отобразить/удалить. 

 



Статус эскиза 

 

Эскиз может находиться в одном из трех состояний: 

1. Полностью определенный – все линии и кривые в эскизе, а также их 

расположение однозначно описываются размерами и (или) взаимосвязями. Цвет 

объектов эскиза – черный, в Дереве построения такой эскиз отображается без каких-

либо значков. 

2. Переопределенный – размеры или взаимосвязи находятся в противоречии 

либо дублируют друг друга. В переопределенном эскизе графические объекты, для 

которых не было найдено решение, имеют красный цвет, объекты, находящиеся в 

конфликте друг с другом, – желтый. В Дереве построения такой эскиз отображается 

со значком «+». 

3. Недоопределенный – не определены некоторые размеры или взаимосвязи, их 

можно изменять. Цвет объектов эскиза – синий. В Дереве построения такой эскиз 

отображается со значком «–». 

Создавать трехмерные объекты без ошибок возможно как для полностью 

определенных эскизов, так и для эскизов, которые недоопределены. В последнем 

случае это дает больше возможностей по моделированию объектов, размеры и форма 

которых заранее неизвестны. Однако на стадии завершения проектирования 

рекомендуется эскизы полностью определить (любые изменения в эскизах с 

полностью заданными параметрами будут предсказуемыми). 

На рис. 2.11 показан пример полностью определенного эскиза с простановкой 

размеров и заданием необходимых взаимосвязей. 

 
Рис. 2.11. Полностью определенный эскиз 

 

  



Задание. Создать трехмерную модель тела вращения, используя инструменты 

работы с деталью “Повернутая бобышка / Основание” и “Повернутый вырез”. 

 
Рис. 1. Ваза (вариант 1): 

а – эскиз; б – разрез; в – 3D-модель 

Примечание. Фаску добавить после создания тела вращения. 

  



 

 
Рис. 2. Ваза (вариант 2): 

а – эскиз; б – разрез; в – 3D-модель 

 

 

 

  



 

 
Рис. 3. Ваза вариант 3: 

а – эскиз; б – разрез; в – 3D-модель 

 

  



 

 
Рис. 4. Ваза (вариант 4): 

а – эскиз; б – разрез; в – 3D -модель 

 



Рекомендации к выполнению задания.  

1. Выбрать плоскость “Спереди”. 

2. Выполнить ориентацию плоскости “Перпендикулярно”. 

3. Создать “Эскиз” 

4. Построения производить инструментами эскиза “Линия” , “Дуга через 3 точки” 

и  ”Касательная дуга” 

5. Провести осевую линию через “Исходную точку” 

6. Начинать построения со дна вазы 

7. Производить построение, последовательно вычерчивая элементы профиля вазы 

с размерами и взаимосвязями элементов 

8. При необходимости между двумя последовательно расположенными дугами 

устанавливать взаимосвязь “Касательный”. 

9. Для элементов дуги, образующие четверть окружности, устанавливать между 

соответствующими точками взаимосвязи “Вертикальный” и “Горизонтальный”, как 

указано на рис. 6.  

 
Рис. 6. Установление взаимосвязей. 

 

10.  Вычертить замкнутый профиль и полностью определить его размерами и 

взаимосвязями. 

11. Выполнить операцию “Повернутая бобышка”. 

12. Для формирования выреза следует создать эскиз выреза (повторить п. 1-10) и 

выполнить операцию “Повернутый вырез”. 

13. Проверку правильности выреза произвести путем отображения разреза детали, 

получаемого от плоскости “Справа”. 

 

  



Лабораторная работа № 3.  

 

Построение трехмерных моделей деталей в SolidWorks 

 

Цель работы – изучение основных методов построения трехмерных моделей 

деталей в системе автоматизированного проектирования SolidWorks. 

 

Методические указания 

 

Деталью в SolidWorks называется трехмерный объект, состоящий из 

некоторого количества элементов. Элементы – это отдельные геометрические 

формы, в сочетании образующие деталь. Основные формообразующие элементы – 

бобышки и вырезы строятся на базе плоских эскизов. Другие элементы – оболочки, 

скругления, фаски преобразуют уже существующую 3D модель. 

 

Основные способы создания твердотельных элементов 

 

В общем случае трехмерная твердотельная модель детали в SolidWorks состоит из 

множества «сконструированных» элементов, или элементарных объемов. 

Наиболее общими способами описания трехмерных объектов являются 

табличные способы, в которых ограничивающая объем формообразующая 

поверхность определяется массивом точек с известными координатами. Такой способ 

используется в универсальных форматах файлов для хранения информации о 

трехмерных объектах. 

Для построения объемов более удобным является аналитический способ: 

формообразующие поверхности являются результатом движения направляющих 

отрезков вдоль одного или нескольких образующих. 

К основным типам элементов в SolidWorks относятся: 

1. Вытягивание (движение по прямой линии); 

2. Вращение (движение по окружности); 

3. По траектории (движение вдоль произвольной кривой); 

4. По сечениям (движение нескольких произвольных образующих вдоль 

нескольких произвольных направляющих). 

В соответствии с этими типами могут быть выполнены бобышки или основания 

(выступающие части детали) и вырезы (рис. 3.1). 

 

  



 

 
Рис. 3.1. Методы создания твердотельной модели в SolidWorks 

 

К дополнительным элементам (скругления, фаски, оболочки и др.) относятся 

наиболее часто используемые варианты, или частные случаи основных элементов. 

Кроме того, для создания элементов твердотельной геометрии могут 

использоваться массивы элементов – линейные и круговые, а также зеркальные копии 

элементов. 

Дополнительно в SolidWorks реализованы операции по преобразованию 

трехмерной геометрии детали: Деформация, Масштабирование, Гибкие и другие. 

Эти операции выполняются с одним элементом и заменяют процесс создания сложной 

геометрии. Другим дополнительным типом операций являются булевы операции. Они 

выполняются с двумя и более элементами и необходимы для объединения элементов в 

единый объект методами логического вычитания или сложения твердых тел. 

Твердотельные модели в SolidWorks можно создавать одним из указанных 

способов. Конечный результат не будет зависеть от выбранного способа, однако для 

лучшего понимания и удобства редактирования рекомендуется выполнять модель 

аналогично технологическому процессу ее изготовления. Если обработку вала 

предусматривается вести с помощью токарных операций, то и модель следует 

получать методами вращения контура. 
 

Вытянутые объекты 

 

Операцию Вытягивания можно представить как процесс перемещения 

нарисованного в Эскизе контура вдоль некоторого отрезка (вследствие перемещения 

окружности будет получен цилиндр). 

Чтобы активизировать операцию, необходимо выполнить команду на панели 

инструментов Вытянутая Бобышка/Основание  (для создания основания) либо 

Вытянутый Вырез  (для создания выреза в построенном твердом теле). 



При построении элемента методом Вытягивания в менеджере свойств 

отображаются три составляющие в виде трех панелей (рис. 3.2): 

– начальное условие для создания элемента (панель «От»); 

– граничные условия; 

– модификации команды. 

 
Рис. 3.2. Примеры начальных условий операции Вытягивания 

 

Комбинации этих составляющих приводят к тому, что для одного и того же 

эскиза будут построены различные варианты конструкций твердого тела. 

В качестве начального условия для создания элемента могут быть заданы: 

– плоскость эскиза; 

– поверхность, грань, плоскость или вершина 3D модели; 

– смещение. 

В первом случае твердое тело будет построено от плоскости, на которой 

находится эскиз, во втором – от выбранного геометрического элемента, а в третьем – 

от условной поверхности, смещенной параллельно плоскости эскиза на заданное 

расстояние. При выборе в качестве начального условия поверхностей, граней или 

плоскостей контур элемента Вытянутая бобышка/основание должен полностью 

находиться в их пределах. 

Граничные условия служат для определения границ вытянутого элемента. Если 

представить, что операция вытягивания выполняется путем перемещения эскиза вдоль 

направленного отрезка, то роль его первой точки будут выполнять начальные условия, 

а второй – граничные. Всего имеется восемь условий, которые в качестве исходной 

информации должны принимать либо численные значения размеров, либо 

геометрические объекты: 

1. На заданное расстояние – определяет границу вытянутого элемента путем 

явного указания глубины вытягивания (значение можно задавать в численном виде 

или перетаскиванием мышкой стрелки-направления вытягивания на предварительном 

виде (рис. 3.3)). 

 



 
Рис. 3.3. Примеры граничных условий операции Вытягивания 

 

2. Через все – эскиз вытягивается через всю существующую геометрию. 

3. До следующей – вытягивается элемент от плоскости эскиза до следующей 

поверхности, заслоняющей весь профиль (следующая поверхность должна 

принадлежать родительской детали). 

4. До вершины – эскиз вытягивается до расположенной параллельно плоскости, 

проходящей через заданную вершину. 

5. До поверхности – элемент заполняет область от плоскости эскиза до 

выбранной поверхности. 

6. На расстоянии от поверхности – элемент заполняет область от плоскости 

эскиза до поверхности, эквидистантной выбранной. 

7. До тела – строится элемент от плоскости эскиза до заданного тела 

(используется в многотельных деталях, сборках, литейных формах). 

8. От средней поверхности – элемент создается путем вытягивания эскиза на 

равную глубину в обоих направлениях от плоскости построения эскиза (см. рис. 3.3). 

Ограничивать вытяжку можно только в одном направлении. Так как эскиз 

относительно плоскости построения разрешается вытягивать в двух взаимно 

противоположных направлениях, воспользуемся двумя панелями инструментов 

Направление 1 и Направление 2. 

Изменить направление вытягивания на противоположное можно, щелкнув на 

кнопке Реверс направления , расположенной слева от раскрывающегося списка. 

Основными модификациями команды Вытянуть являются: 

Создание многотельных деталей. Если флажок Результат слияния снять, то 

базовый элемент и вытягиваемый, эскиз которого построен на одной из поверхностей 

базового, будут представлять собой разные твердые тела (нечто вроде сборки, 

помещенной в файл детали). 

Направление вытяжки. По умолчанию SolidWorks выполняет вытяжку контура 

элемента перпендикулярно плоскости эскиза, однако можно указать произвольный 

угол наклона вектора вытяжки с помощью двухмерного или трехмерного эскиза. 

Угол уклона при вытягивании эскиза. При наличии уклона результирующий 

элемент будет иметь сужение или расширение (вместо цилиндра получается конус, 

параллелепипеда – пирамида и т.д.). 

Для выполнения модификации достаточно нажать кнопку 

Включить/Выключить уклон, задать угол и направление сужения (внутрь/наружу). 

Тонкостенный элемент. Тонкостенные вытянутые элементы можно создавать на 

основе как замкнутых, так и незамкнутых эскизов. Эта операция требует указания 

направления смещения эскиза (внутрь или наружу) для создания полости внутри 

элемента, а также величины смещения в каждом направлении. Метод определения 



толщины задается в раскрывающемся списке Тип: в одном направлении 

(используется для добавления толщины с одной стороны эскиза); от средней 

поверхности (равная толщина в обоих направлениях); в двух направлениях 

(разная толщина с двух сторон от эскиза). 

Торцевая пробка. Отображается только в случае создания тонкостенного 

элемента, эскиз которого является замкнутым контуром. Если этот флажок 

установлен, то на двух концах вытянутого тонкостенного элемента создаются 

грани с заданной толщиной (устанавливается в соответствующем счетчике). 

Выбранные контуры. Позволяет использовать неполный эскиз для 

создания вытяжки элементов. 
 

Повернутые элементы 

 

Повернутые элементы добавляют или удаляют материал путем поворота одного 

или нескольких профилей вокруг осевой линии. Можно создавать Повернутые 

бобышки/основания, Повернутые вырезы или Повернутые поверхности. 

Повернутый элемент может быть твердотельным элементом, тонкостенным элементом 

или поверхностью. 

При создании тел вращения существует несколько ограничений: 

– в эскизе должна присутствовать минимум одна линия со свойством 

вспомогательная геометрия – ось вращения; 

– контур не может пересекать осевую линию или касаться ее в изолированной 

точке; 

– контур должен быть замкнутым (иначе будет создана тонкостенная деталь). 

Инструмент Повернутая бобышка/основание  предоставляет три 

возможных варианта построения модели: Элемент вращения, Тонкостенный 

элемент и элемент, построенный на основе замкнутых выбранных контуров эскиза 

(рис. 3.4). 

Эскиз повернутого элемента может состоять из одного или нескольких замкнутых 

контуров, осей вращения, построенных осевой вспомогательной линей. Если в эскизе 

несколько осей, то ось, вокруг которой будет поворачиваться контур, необходимо 

указать при построении твердотельного элемента (при нажатии левой кнопки мыши). 

При построении элемента обязательно должны быть указаны направление и угол 

поворота (рис. 3.4). 



 
Рис. 3.4. Основные параметры операции вращения в SolidWorks 

 

 

Тонкостенный элемент вращения применяется в основном для создания 

оболочковых форм. Для тонкостенного элемента дополнительно требуется указание 

направления и численного значения толщины (для этого варианта не обязательно 

наличие замкнутого контура). 

Вариант построения тела вращения на основе Выбранных контуров 

применяется в случае, когда контур вращения удается задать только в виде 

комбинации отдельных сложных фигур. 

При выборе способа построения твердого тела методом вращения необходимо 

учитывать степень сложности профиля эскиза. Изначально сложность эскиза для 

элементов, полученных вращением, будет выше. 

В общем случае, чем сложнее эскиз, тем меньшее количество конструктивных 

элементов понадобится для построения детали, более рационально будут 

использованы ресурсы компьютера. Однако разработчику проще контролировать 

процесс построения модели, если эскизы будут максимально упрощены (в эскизах не 

содержатся мелкие конструкционные элементы: скругления и фаски). 

 

Элемент по траектории 

 

При использовании элемента По траектории  создаются основание, 

бобышка, вырез или поверхность путем перемещения контура (профиля) по 

направляющей (маршруту). В отличие от элементов Вытянутая 

бобышка/основания и Повернутая бобышка/основания для построения 



элемента По траектории необходимо выполнить два Эскиза: один эскиз с 

изображением профиля, второй – с изображением маршрута движения. 

Основные правила построения элемента По траектории: 

1. Профиль должен быть замкнутым для основания или бобышки по 

траектории, для элемента поверхности по траектории профиль может быть 

замкнутым или разомкнутым. 

2. В качестве направления может выступать разомкнутая кривая или 

замкнутая. 

3. Направление может быть множеством из нарисованных кривых, 

содержащихся в одном эскизе, кривой или множеством кромок модели. 

4. Начальная точка направления маршрута должна лежать на плоскости 

профиля. 

На рис 3.5 показан пример построения трехмерной модели заготовки для 

изготовления ручки электронного блока методом Вытянутой 

Бобышки/Основания по Траектории. Эскизы профиля и направления 

построены на взаимно перпендикулярных плоскостях Спереди и Сверху 

соответственно. 
 

 
Рис. 3.5. Построение элемента По траектории 

 

Содержание вкладок Параметры и Начать, закончить касание элемента По 

траектории используется для создания сложной геометрии модели. Опция 

Направляющие кривые используется для определения линий, направляющих 

профиль, когда он вытягивается вдоль маршрута. Пример использования 

направляющих кривых – создание элемента с изменяющимся профилем. 

Полное описание этих составляющих содержится в справочной системе 

SolidWorks. 

 

Элемент по сечениям 

 

Команда По сечениям  создает элемент путем построения переходов между 

профилями (рис. 3.6). Элемент по сечениям может быть основанием, бобышкой, 

вырезом или поверхностью. Для конструирования такого элемента необходимо не 

менее двух сечений. 



 
Рис. 3.6. Построение элемента По сечениям с использованием  

начальных и конечных ограничений 

 

В окне Профили необходимо указать контуры, которые используются для 

создания элемента по сечениям. В качестве профиля можно применять: 

– плоские эскизы на плоскостях трехмерного пространства; 

– грани (не обязательно плоские) ранее построенной модели либо грани, 

созданные линями разъема, плоскими профилями или поверхностями; 

– кромки существующих элементов; 

– точки эскиза (в качестве крайних профилей). 

Для твердотельного элемента Бобышка/основание по сечениям крайние 

профили обязательно должны быть гранями модели, плоскими эскизами либо 

точками. 

Элементы по сечениям строятся на основе порядка выбора профиля. Изменение 

порядка выполняется при помощи кнопок  и . 

Обязательной составляющей элемента По сечениям является Направляющая 

кривая. Даже если Направляющая кривая не была построена заранее в отдельном 

эскизе, ее роль выполняет виртуальная линия, которая образуется в процессе выбора 

сечений и отображается в графической области. Управлять виртуальной 

направляющей возможно перемещением ее конечных точек (см. рис. 3.6). 

Для точного построения трехмерной геометрии методом По сечениям 

использование Направляющих кривых является обязательным. Основными 

требованиями к направляющей кривой являются: 

– направляющая должна лежать в плоскости, которая пересекает плоскости 

сечения; 

– направляющая должна пересекать профили; 

– в качестве направляющей можно использовать линии ранее созданных 

объектов. 

Элементы По сечениям являются наиболее сложным для построения из всех 

четырех аналитических способов построения трехмерной геометрии в SolidWorks. 

Полное описание параметров элемента По сечениям содержится в справочной 

системе SolidWorks. 



Элементы По сечениям могут быть использованы при разработке оригинальных 

корпусов и лицевых панелей электронных приборов со сложным дизайном, а также 

для создания элементов с геометрией, изменяющейся по определенным заданным 

законам. 

 

Справочная геометрия 

 

Для использования ряда инструментов работы с трехмерными моделями 

необходимо применять дополнительные элементы построения: оси, плоскости, точки, 

не относящиеся ни к одному элементу или эскизу модели. 

Для построения подобных объектов в SolidWorks используются инструменты 

Справочной геометрии: Плоскость, Ось, Система координат, Точка, Ссылка на 

сопряжение (рис. 3.7). 

 
Рис. 3.7. Элементы Справочной геометрии SolidWorks 

 

Наиболее часто при создании твердотельной трехмерной модели используются 

инструменты Плоскость и Ось. Дополнительные Плоскости применяются в 

элементах по траектории и по сечениям. 

Оси необходимы для создания круговых массивов элементов. Все созданные 

Справочной геометрией объекты будут отображаться как в Графической области, 

так и в Дереве построения. 

Для инструментов Плоскость и Ось в окне группы Выбор необходимо указать 

способ создания справочной плоскости (при нажатии соответствующей пиктограммы) 

и выбрать в графической области объекты, на базе которых плоскость будет 

построена. В качестве объектов могут выступать ранее созданные плоскости, линии, 

точки, элементы эскизов, кривые и поверхности (см. рис. 3.7). 

  



 

Инструменты создания фасок и скруглений 

 

Фаски и скругления относятся к мелким конструкционным элементам деталей. В 

общем случае результатом работы соответствующих инструментов Фаска и 

Скругление является изменение формы кромок трехмерной модели. 

Инструмент Фаска создает скос на выбранных кромках, гранях или вершине. 

Окно свойств содержит параметры выбора объектов (кромки, вершины или грани), а 

также задание типа определения фаски и необходимые размеры (рис. 3.8). Наиболее 

часто используемым типом является определение расстояния и угла фаски 

(отображается на чертежах по ЕСКД). 

 
Рис. 3.8. Инструмент создания фаски в SolidWorks 

 

Инструмент Скругление  создает скругленную внутреннюю или внешнюю 

грань на детали. Можно скруглить все кромки грани, выбранные множества граней, 

выбранные кромки или петли. 

Общие правила при создании скруглений: 

– большие скругления следует строить раньше малых; 

– необходимые уклоны в трехмерной модели (литейные детали) следует 

выполнять перед скруглениями; 

– мелкие скругления выполнять в самую последнюю очередь; 

– необходимо использовать единую операцию Скругление с одинаковым 

радиусом для нескольких кромок. 

С точки зрения разработчика добавление скруглений способствует эстетической 

привлекательности изделия. Скругления также предупреждают появление 

нежелательных концентраций напряжения и позволяют избежать острых граней. 

Скругления переменного радиуса являются одним из методов создания сложной 

геометрии детали. 

 

  



Инструменты создания массивов твердотельных элементов 

 

В общем случае любой массив основан на исходном элементе. 

Процесс проектирования с использованием массивов компонентов состоит из 

двух этапов: 

1. Создается базовая часть детали. 

2. Тело копируется с помощью соответствующего инструмента с целью 

получения оставшейся геометрии. 

Наиболее простой формой создания трехмерного массива является Зеркальное 

отражение . 

Для зеркального копирования требуется выделить плоскость симметрии (любая 

плоскость или грань модели), а также копируемые элементы, грани либо твердые тела 

(рис. 3.9). 

 
Рис. 3.9. Реализация инструмента Зеркальное отражение 

 

Для инструмента Линейный массив  следует выбрать элементы, затем 

указать направление (любая прямая линия, принадлежащая трехмерному объекту или 

эскизу), линейный интервал и общее число повторений. 

Для Кругового массива необходимо выбрать элементы, кромку или ось в 

качестве центра вращения. Параметры массива определяются общим числом 

повторений и угловым интервалом между экземплярами (рис. 3.10). 

 
Рис. 3.10. Инструмент Круговой массив 

 



 

Команда Оболочка  используется для создания тонкостенных элементов. При 

этом выбранные грани остаются открытыми, тонкостенные элементы создаются на 

остальных гранях. Если на модели не выбрана никакая грань, можно создать оболочку 

твердотельной детали, тем самым создав замкнутую полую модель. 

Инструмент Оболочка требует для ввода две группы исходных данных: 

1. Настройки – указывается толщина стенок модели по умолчанию для всех 

поверхностей, а также грани, которые будут удалены с целью создания незамкнутой 

полой модели. 

2. Настройки – разная толщина – указываются поверхности, толщина стенок 

которых должна отличаться от принятой по умолчанию. 

В некоторых моделях построить оболочку не удается по причине конфликтов 

геометрии: указанное значение толщины оболочки превышает минимальное значение 

радиуса кривизны поверхности. В этом случае необходимо исправить модель или 

изменить значение толщины оболочки. В SolidWorks существует инструмент 

диагностики подобных ошибок: верхнее меню Инструменты>>Проверить (рис. 

3.11). 

 
Рис. 3.11. Диагностика ошибок трехмерной модели 

 

Правила построения трехмерных моделей деталей 

 
При проектировании электронных средств к деталям SolidWorks, требующим 

построения трехмерной параметрической модели, могут быть отнесены: 

– оригинальные детали изделий; 

– типовые покупные изделия (электрорадиоэлементы, корпуса, крепежные 

детали); 

– стандартные изделия (крепеж). 



Несмотря на то что общей библиотеки трехмерных моделей типовых и 

стандартных изделий не существует, часть из них промоделирована. Подобная работа 

проводится на предприятиях, занимающихся разработкой электронной аппаратуры, в 

учебных заведениях, ведущих подготовку в области трехмерных САПР, а также при 

поддержке сервиса компании SolidWorks (Web-ресурс www.3DContentCentral.com). В 

общем случае разработчик электронной аппаратуры должен быть готовым строить 

модели любых изделий, в том числе и типовых. 

Процесс построения трехмерных моделей деталей следует начинать с наиболее 

крупных конструктивных элементов, постепенно удаляя материал либо добавляя 

более мелкие элементы. Разработку составляющих конструкции, которые не 

принимают участия в создании других элементов (например, фаски, скругления, 

крепежные отверстия и т.п.), необходимо перенести на последние этапы 

моделирования. Если изделие имеет одну или несколько плоскостей симметрии, более 

целесообразно (и менее трудоемко) смоделировать лишь часть конструкции, а 

остальное получить методом зеркального отображения. 

 

Модель, состоящая из нескольких элементов, может быть построена в различном 

порядке их следования, а также различными методами. Следующий пример наглядно 

указывает на то, что порядок формирования независимых элементов детали может 

быть различным. На следующих примерах наглядно показано, что независимые по 

очередности построения элементы детали позволяют производить их формирование в 

различном порядке следования. 

В следующих примерах на рис. 3.12-3.13 приведены варианты построения одной 

и той же модели разными способами, где видно, что можно выбирать для основания 

как разные плоскости, так и различные эскизы на одной и той же плоскости. 

Способ 1 (рис. 3.12). Поэтапное создание детали путем добавления простых 

элементов. Изначальный выбор плоскости для построения основания – “Сверху”. 



 
Рис. 3.12. Построение модели детали за 9 шагов. 

Способ 2 (рис. 3.13). Создание детали путем добавления более сложных 

элементов). Изначальный выбор плоскости для построения основания – “Сверху”. 

 
Рис. 3.13. Построение модели детали за 5 шагов. 

 

 



Из сравнения четырех вариантов построения детали видно, что существует более 

простой и понятный способ построения детали – поэлементно (вариант 1). Вариант 2 

является более сложным, но состоит из меньшего числа построений. 

 

Лабораторное задание 

 

Задание.  

1. Создать трехмерную модель с заданным числом построений (число построений 

указано в скобках), используя инструменты работы с деталью “Вытянутая 

бобышка/Основание” и “Вытянутый вырез”. 

 



 

 
  



 

 



 
 

  



 

 
  



Лабораторная работа № 4.  

 

Редактирование элементов модели в SolidWorks 

 

Цель работы – изучение методов редактирования моделей в системе 

автоматизированного проектирования SolidWorks. 

 

Редактирование является одним из наиболее важных аспектов процесса 

разработки продукта. Почти все проекты требуют редактирования либо в процессе 

разработки, либо после ее завершения. Проект, созданный в SolidWorks, представляет 

собой комбинацию отдельных элементов, объединенных для формирования 

твердотельной модели. Все эти элементы могут быть отредактированы 

индивидуально. Например, на рис. 4.1 представлена пластина основания с 

несколькими отверстиями. 

Если вам необходимо заменить четыре цилиндрических отверстия на четыре 

расточенных, все, что нужно сделать, – это использовать одну операцию 

редактирования. Тем самым вы измените простые отверстия на расточенные. Для 

редактирования отверстий следует выбрать элемент «отверстие» и вызвать 

контекстное меню щелчком правой кнопки мыши. Затем необходимо выбрать пункт 

меню Edit Feature (Редактировать определение), чтобы вызвать 

диалоговое окно Hole Definition (Определение отверстия). После этого 

следует задать новые параметры и завершить создание элемента. Простые отверстия 

будут автоматически заменены расточенными (рис. 4.2). 

 

 
 Рис. 4.1. Пластина с цилиндрическими           Рис. 4.2. Измененная пластина 

        отверстиями 

 

Аналогичным образом можно редактировать вспомогательную геометрию и 

эскизные элементы. Элемент, созданный на основе вспомогательной геометрии, также 

автоматически изменяется, когда вы изменяете вспомогательную геометрию. 

Например, если вы создаете элемент на наклонной плоскости и затем меняете ее угол 

наклона, результирующий элемент будет автоматически изменен. В SolidWorks вы 

можете выполнять редактирование, используя различные методы.  

 

  



Команда редактирования Edit Feature 

(Редактировать определение) 
 

Редактирование с использованием команды Edit Feature (Редактировать 

определение) наиболее часто используется в SolidWorks. Для редактирования 

элемента модели посредством этой команды выберите элемент в дереве 

конструирования Feature Manager или в графической области. После выбора 

элемента следует вызвать контекстное меню щелчком правой кнопки мыши и выбрать 

в нем команду Edit Feature (Редактировать определение), как показано 

на рис. 4.3. В зависимости от того, какой элемент выбран, на экране появится 

менеджер свойств или соответствующее диалоговое окно, в котором вы сможете 

изменить параметры элемента. 

Менеджеру свойств будет присвоен порядковый номер редактируемого элемента. 

Например, на рис. 4.4 изображен менеджер свойств элемента Extrude (Вытянуть) 

с порядковым номером 2. 

 

 
     Рис. 4.3. Выбор команды Редактировать            Рис. 4.4. Менеджер свойств 

            определение из контекстного меню                         элемента Вытянуть2 

 

После изменения параметров щелкните на кнопке ОК, чтобы завершить создание 

элемента. Элемент будет изменен автоматически. 

  



 

Редактирование эскизов элементов 

 

В SolidWorks можно редактировать эскизы элементов при помощи команды Edit 

Sketch (Редактировать эскиз). Для редактирования эскиза выберите элемент 

либо через дерево конструирования Feature Manager, либо в области построений 

и вызовите контекстное меню щелчком правой кнопки мыши. Выберите команду 

Edit Sketch (Редактировать эскиз) из контекстного меню (рис. 4.5).  

 
Рис. 4.5. Выбор команды Редактировать эскиз 

 

Таким образом вы попадаете в эскизную среду. Используя стандартные 

инструменты эскизной среды, отредактируйте эскиз элемента. Закончив 

редактирование эскиза, выйдите из эскизной среды. Для этого следует щелкнуть на 

кнопке  Rebuild (Перестроить) на панели инструментов Standard 

(Стандартная). После этого вы выйдете из эскизной среды, и модель будет 

автоматически перестроена. Кроме того, вы можете использовать комбинацию клавиш 

Ctrl+B, чтобы перестроить модель. 

Совет. Вы можете также щелкнуть на значке «+» слева от элемента, чтобы 

развернуть этот элемент в дереве конструирования Feature Manager. При этом 

будет отображен значок эскиза для данного элемента. Выберите значок эскиза и 

вызовите контекстное меню щелчком правой кнопки мыши. Выберите в нем команду 



Edit Sketch (Редактировать эскиз), чтобы войти в среду редактирования 

эскизов. 

 

Редактирование двойным щелчком мыши на элементе дерева или эскиза 

 

Вы также можете редактировать элемент, вспомогательную геометрию или эскиз 

путем двойного щелчка на элементе в дереве конструирования Feature Manager 

или в области построений. Например, если вы дважды щелкнете на вытянутом 

элементе, все размеры этого элемента и его эскиз будут отображены в области 

построений. Обратите внимание, что все размеры эскиза будут отображаться черным 

цветом, а размеры элемента – голубым. Дважды щелкните на размере, который вы 

хотите изменить, и на экране появится диалоговое окно Modify (Изменить). 

Задайте новое значение размера в этом окне и нажмите клавишу Enter на клавиатуре 

или щелкните на кнопке Save the current value and exit the dialog 

(Сохранить текущее значение и выйти) в диалоговом окне.  

 
Рис. 4.6. Диалоговое окно Изменить 

 

Вы заметите, что значение размера изменилось, но модель осталась без 

изменений. Теперь следует перестроить модель командой Rebuild 

(Перестроить). Для этого можно щелкнуть на кнопке Rebuild (Перестроить) 

на панели инструментов Standard (Стандартная) или нажать сочетание клавиш 

Ctrl+B. 

  



Редактирование с использованием инструментов Instant 3D 

 

С помощью инструментов Instant 3D можно быстро и точно создать 

геометрию детали.  Используя эти инструменты, вы можете динамически изменять 

элементы и эскизы элементов без перехода в эскизную среду. 

Для перехода в режим Instant 3D нужно нажать кнопку  на панели 

инструментов Элементы. В режиме Instant 3D при выборе элемента 

отображаются сферические маркеры и стрелки, используемые для перемещения и 

изменения размера геометрии детали путем их перетаскивания.  

Для редактирования твердотельной геометрии выберите грань. Выбранная 

поверхность будет выделена голубым цветом, а на грани отобразятся стрелки и 

маркеры. 

 
Рис. 4.7. Изменение размеров элемента в режиме Instant 3D. 

 

Чтобы изменить размер элемента, подведите указатель мыши к 

соответствующему маркеру. Стандартный указатель при этом будет изменен на 

указатель масштабирования, и рядом с ним появится линейка. Нажмите левую кнопку 

мыши и, удерживая ее, перетащите указатель для масштабирования элемента. Элемент 

будет динамически менять размеры, которые отражаются на линейке. Отпустите 

левую кнопку мыши, когда элемент примет требуемые размеры. Процесс 

перетаскивания указателя для изменения размеров элемента показан на рис. 4.7.  

 



На выбранной грани отображается двухосная система координат. Если элемент 

недоопределен, ее можно использовать для перемещения элемента. Если грань 

полностью определена, то отобразится символ, показывающий, что перемещение 

невозможно. При перемещении грани в направлении, противоположном вытяжке, 

элемент может измениться. Бобышку можно изменить на вырез и наоборот в 

зависимости от направления и расстояния перетаскивания.  

Примечание. Если вы перемещаете эскизный элемент, у которого эскиз 

определен полностью или частично через взаимосвязи и размеры, появляется 

диалоговое окно Передвинуть утверждение, показанное на рис. 4.8. Это окно 

информирует вас о том, что в элементе изменены внешние связи, и спрашивает, хотите 

ли вы удалить эти связи или сохранить их, пересчитав, или оставить связи зависшими. 

Связи или размеры, которые не связаны с внешними ссылками после их установления, 

становятся зависшими. 

 
Рис. 4.8. Диалоговое окно Передвинуть утверждение 

 

 

Редактирование элементов и эскизов командами 

Cut (Вырезать), Сору (Копировать) и Paste(Вставить) 

 

В SolidWorks предлагаются стандартные возможности Windows по вырезанию, 

копированию и вставке объектов и эскизов. Применяют их так же, как и в любом 

другом приложении Windows. Выберите элемент или эскиз, который вы хотите 

вырезать или скопировать. Чтобы вырезать выделенный элемент модели, выберите 

пункт меню Edit ► Cut (Правка ► Вырезать) или используйте комбинацию 

клавиш Ctrl+X. На экране появится диалоговое окно подтверждения удаления, 

поскольку вырезаемый элемент будет удален из документа. Щелкните на кнопке Yes 

(Да) в диалоговом окне. После того как вы вырезали элемент модели, выберите 

плоскость или другой ориентир для вставки элемента в модель. Выберите пункт меню 

Edit ► Paste (Правка ► Вставить) или используйте комбинацию клавиш 

Ctrl+V. Иногда при этом выводится диалоговое окно Copy Confirmation 

(Подтверждение копирования) (рис. 4.9), в котором предлагается либо удалить 

внешние связи элемента, либо оставить их зависшими. Это диалоговое окно 

отображается, только если на вставляемый элемент наложены ограничения в виде 

связей или размеров. Элемент будет вставлен в то место, которое задано выбранным 

ориентиром. 



 
Рис. 4.9. Диалоговое окно подтверждения копироваия. 

 

Совет. Чтобы вставить выбранный эскиз, необходимо выбрать плоскость или 

плоскую поверхность для привязки. Для вставки эскизного элемента, простого 

отверстия или отверстия, созданного при помощи мастера отверстий, также следует 

выбрать плоскость или плоскую поверхность. Для вставки фасок и Скруглений 

необходимо выбрать кромку, кромки или поверхность для привязки. 

 

После вставки скопированного элемента модели его оригинал остается в 

исходном положении, а копия помещается на выбранный элемент. Чтобы скопировать 

элемент модели, выберите элемент или эскиз. Затем выберите пункт меню Edit 

►Сору (Правка ► Копировать) или используйте комбинацию клавиш Ctrl+C. 

Выберите элемент, на который следует поместить копию, и выберите пункт меню 

Edit ► Paste (Правка ► Вставить) или используйте комбинацию клавиш 

Ctrl+V. 

Вставлять элементы можно неограниченное число раз. Если вы выберете другой 

элемент для копирования и скопируете его в буфер обмена, предыдущий элемент 

будет удален из буфера. 

 

Удаление элементов. Вы можете удалять ненужные элементы модели, выделяя 

их в дереве конструирования Feature Manager или в области построений. Выделив 

элемент, нажмите клавишу Delete или вызовите контекстное меню щелчком правой 

кнопки мыши и выберите в нем команду Delete Feature (Удалить элемент). 

При удалении элемента появляется диалоговое окно Confirmation Delete 

(Подтверждение удаления), приведенное на рис. 4.10. 



 
Рис. 4.10. Диалоговое окно подтверждения удаления.  

 

Если установить в этом диалоговом окне флажок Also delete all child 

features (Удалить все дочерние элементы), то все элементы, созданные 

на основе удаляемого элемента, также будут удалены. Когда вы удаляете элемент, 

созданный на основе эскизов, соответствующие эскизы не удаляются. Эти эскизы 

называются поглощаемыми элементами. Если вам необходимо удалить и 

поглощаемые элементы вместе с основным, установите флажок Also delete 

absorbed features (Удалить все поглощаемые элементы) в диалоговом 

окне подтверждения удаления. Далее щелкните на кнопке Yes (Да), чтобы удалить 

выбранные элементы, или на кнопке No (Нет), чтобы отменить операцию удаления. 

Для удаления выделенного элемента можно также выбрать пункт меню Edit ► 

Delete (Правка ► Удалить). 

 

Гашение элементов. Меню: Edit ► Suppress ► This Configuration 

(Правка ► Погасить ►Текущая конфигурация) 

Иногда возникают ситуации, когда отображать некоторые элементы в модели или 

на чертежах этой модели нежелательно. Вместо того чтобы удалять эти элементы, их 

можно погасить. Такие элементы не видны ни в модели, ни на чертеже. Если вы 

создаете сборку с использованием этой модели, то погашенные элементы не будут 

отображаться даже в составе сборки. В любой момент вы можете восстановить 

отображение погашенного элемента. Если вы гасите элемент, от которого зависят 

другие элементы, то эти элементы тоже оказываются погашенными. Чтобы погасить 

элемент, выделите его в дереве конструирования FeatureManager или в области 

построений. Щелкните правой кнопкой мыши и выберите в контекстном меню 

команду  Suppress (Погасить). Погашенный элемент будет удален из 

области построений, а его значок в дереве конструирования FeatureManager будет 

отображен серым цветом. Зависящие от него элементы будут также погашены. 



 
Рис. 4.11. Выбор команды Погасить из контекстного меню.  

 

Примечание. В пределах одного документа SolidWorks вы можете работать с 

различными конфигурациями. Поэтому необходимо указать, в какой конфигурации вы 

гасите элемент. Это можно сделать при выборе команды сокрытия из меню.  

Отмена гашения элементов. Чтобы возобновить отображение погашенного 

элемента, выберите его в дереве конструирования FeatureManager, а затем 

выберите пункт меню Edit ► Unsuppress ► This Configuration (Правка 

► Высветить ► Текущая конфигурация). Вы также можете выбрать эту 

команду   из контекстного меню после выделения погашенного элемента. Как 

уже было сказано, при гашении элемента все зависящие от него элементы тоже 

гасятся. Но при отмене гашения элемента зависящие от него элементы остаются 

погашенными. Поэтому вам придется отменять гашение для каждого зависимого 

элемента отдельно. Метод восстановления видимости элемента вместе с зависимыми 

элементами описан ниже. 

Отмена гашения элементов вместе с зависимыми элементами.  

 
Используя эту команду, вы можете восстановить видимость погашенного 

элемента вместе с зависящими от него элементами. Выберите погашенный элемент в 

дереве конструирования FeatureManager. Выберите пункт меню Edit ► 

Unsuppress with Dependents ► This Configuration (Правка ► 



Восстановить вместе с зависимыми ►Текущая конфигурация). 

Погашенный элемент будет снова выведен на экран вместе со всеми зависящими от 

него элементами. 

Переименование элементов. Имена элементов отображаются в дереве 

конструирования Feature Manager. По умолчанию имена присваиваются 

элементам в соответствии с последовательностью их создания. Вы можете 

переименовывать элементы по своему усмотрению. Чтобы переименовать элемент, 

выделите его в дереве конструирования и щелкните на элементе еще один раз. В 

дереве конструирования появится поле для ввода имени элемента. Введите имя и 

нажмите Enter или щелкните мышью в любом месте экрана. 

 

Упражнение 1.  

 

В этом упражнении мы создадим модель, показанную на рис. 4.12. После 

создания нескольких элементов модели мы динамически модифицируем ее, а затем 

отменим внесенные изменения. Размеры модели приведены на рис. 4.13.  

 
Рис. 4.12. Модель к упражнению 1 

 

Далее приведена последовательность действий для создания вышеописанной 

модели. 

1. Создайте базовый элемент модели путем вытягивания профиля на заданное 

расстояние (рис. 4.14 и 4.15). 

2. Добавьте Скругления к базовому элементу (рис. 4.16 и 4.17). 

3. Добавьте к модели оболочечный элемент и удалите верхнюю поверхность 

базового элемента (рис. 4.18 и 4.19). 

4. Динамически измените модель, как показано на рис. 4.20 - 4.21. 

5. Создайте вырезы на боковых поверхностях модели (рис. 4.22). 



6. Создайте прорези в нижней части базового элемента и добавьте Скругления к 

вырезам (рис. 4.22). 

7. Размножьте скругленные вырезы (рис. 4.22). 

8. Создайте плоскость на заданном расстоянии от верхней плоскости. 

9. Создайте ножку для модели, используя инструменты вытягивания и 

Скругления. Затем размножьте ножки, как показано на рис. 4.23. 

 
Рис. 4.13. Виды и размеры модели к упражнению 1 

 

Создание базового элемента.  Сейчас мы создадим эскиз базового элемента на 

передней плоскости и вытянем его, используя параметр Mid Plane (От средней 

поверхности). 

1. Запустите SolidWorks и создайте новый документ в режиме Part 

(Деталь). 

2. Используя инструмент Extruded Boss/Base (Вытянутая 

бобышка/основание), постройте эскиз базового элемента на передней плоскости. 

Добавьте требуемые связи и размеры на эскиз (рис. 4.14). 



 
Рис. 4.14. Эскиз базового элемента 

 

3. Вытяните эскиз на 35 мм с параметром Mid Plane (Срединная 

поверхность) Модель базового элемента показана на рис. 4.15. 

 

 
Рис. 4.15. Базовый элемент модели 

 

Добавление Скругления к базовому элементу.  

После создания базового элемента добавим Скругления к его нижним кромкам. 

1. Вызовите менеджер свойств Скругления, поверните модель и выберите 

кромки базового элемента (рис. 4.16). 

2. Установите значение 2,5 в счетчике Radius (Радиус) и щелкните на кнопке 

ОК. Модель после добавления Скруглений на кромки показана на рис. 4.17. 

 

 



 
   Рис. 4.16. Выбираемые кромки               Рис.4.17. Модель со скругленными кромками 

 

Добавление оболочечного элемента к модели. 

После создания Скруглений следует добавить к модели оболочечный элемент, 

используя инструмент Shell (Оболочка). 

1. Сориентируйте модель к изометрическому виду и вызовите менеджер свойств 

Shell (Оболочка). 

2. Выберите верхнюю плоскую грань модели (рис. 4.18). 

3. Установите значение 1 в счетчике Thickness (Толщина) и щелкните на 

кнопке ОК. Модель после добавления оболочечного элемента приведена рис. 4.19. 

 
Рис. 4.18. Выбираемая поверхность элемента 



 
Рис. 4.19. Модель с оболочечным элементом 

 

Динамическое изменение элементов. После добавления оболочки к базовой 

модели вы научитесь динамически изменять элементы с использованием инструмента 

Instant 3D. 

1. Щелкните на кнопке Instant 3D. 

2. В области построений выделите правую плоскую грань базового элемента. 

Выделенная поверхность будет закрашена голубым цветом. Эскиз выбраного элемента 

будет отображен в области построений вместе с различными маркерами 

редактирования. 

3. Выделите маркер масштабирования в области построений и перетащите 

указатель, чтобы изменить размер элемента. В области построений будет отображен 

предварительный вид масштабируемого элемента и будет выведен новый размер. 

Размер обновляется автоматически при перемещении указателя. 

4. Отпустите левую кнопку мыши после перетаскивания элемента на некоторое 

расстояние. Предварительное изображение изменяемого элемента показано на рис. 

4.20. Отредактированный элемент показан на рис. 4.21. 

 

 Рис. 4.20.Перетаскивание маркера               Рис.4.21. Отредактированный элемент 

                изменения размеров 

 



5. Снова щелкните на кнопке Instant 3D, чтобы отключить динамическое 

редактирование, и щелкните в любом месте области построений, чтобы снять 

выделение со всех элементов. 

Мы отредактировали модель путем перетаскивания, но исходная глубина 

элемента была 35 мм. Отредактируем элемент, чтобы вернуть ему требуемую глубину. 

6. Щелкните дважды на элементе в дереве конструирования или в области 

построений. Все размеры элемента будут отображены в области построений. 

7. Дважды щелкните на размере синего цвета, соответствующем глубине. 

8. Вы увидите диалоговое окно Modify (Изменить). Установите значение 35 в 

счетчике Dimension (Размер) и нажмите Enter. 

9. Выберите команду Rebuild (Перестроить) или нажмите комбинацию 

клавиш Ctrl+B, чтобы перестроить модель. Используя инструменты Extruded 

Cut (Вытянутый вырез), Fillet (Скругление) и Linear Pattern 

(Линейный массив), создайте оставшиеся элементы модели. Модель после 

создания этих элементов показана на рис. 4.22. 

 
Рис. 4.22. Модель после создания остальных элементов 

 

Создание ножек. Теперь нужно создать ножки модели. Ножка создается путем 

вытягивания эскиза. Эскиз выполняется в плоскости, смещенной на некоторое 

расстояние от плоскости Тор (Вид сверху). Кроме того, при создании этого 

элемента необходимо задать угол наклона. 

1. Создайте справочную плоскость на расстоянии 10,5 мм от плоскости Тор 

(Вид сверху). При этом следует установить флажок Reverse Direction 

(Реверс направления) в менеджере свойств плоскости. 

2. Выберите созданную плоскость эскиза, начертите эскиз ножки и установите 

необходимые размеры и связи. Эскиз состоит из окружности диаметром 1 мм. 

Остальные размеры приведены на рис. 4.13. 

3. Вытяните эскиз, используя параметр Up to next (До следующего) с 

углом на клона наружу 10°. Скройте справочную плоскость. В результате получится 

ножка модели. 



4. Поверните модель и добавьте Скругление радиусом 0,25 к основанию опоры. 

Повернутый и увеличенный вид завершенной ножки приведен на рис. 4.23. 

5. Размножьте ножку, используя инструмент Linear Pattern (Линейный 

массив). Изометрический вид готовой модели приведен на рис. 4.24. 

 

 
Рис. 4.23.Повернутый и увеличенный вид           Рис.4.24. Окончательный вид 

                модели с ножкой                                               модели 

 

Сохранение модели 

1. Щелкните на кнопке Save (Сохранить) на панели инструментов 

Standard (Стандартная) и сохраните модель. 

2. Закройте документ, выбрав пункт меню File ► Close (Файл ► Закрыть). 

 

Упражнение 2.  

 

В этом упражнении мы создадим модель, показанную на рис. 4.25. В процессе 

создания модели мы также выполним несколько операций редактирования. Виды и 

размеры модели показаны на рис. 4.26. Последовательность действий по созданию 

модели приведена далее. 

1. Создайте основание модели путем поворота эскиза, созданного на плоскости 

Front (Фронтальная), как показано на рис. 4.27 и 4.28. 

2. Сделайте модель оболочечной, используя инструмент Shell (Оболочка), 

как показано на рис. 4.29. 

3. Начертите эскиз на плоскости Тор (Вид сверху) и вытяните его на заданное 

расстояние (рис. 4.30). 

4. Размножьте вытянутый элемент, используя инструмент Circular Pattern 

(Круговой массив), как показано на рис. 4.31. 

5. Отредактируйте круговой массив элементов (рис. 4.32) 

6. Создайте вырез на верхней плоской грани основания (рис. 4.33). 

7. Размножьте вырез, используя инструмент Linear Pattern (Линейный 

массив), как показано на рис. 4.34. 

8. Включите скрытые элементы и создайте оставшиеся элементы модели в 

соответствии с рис. 4.35 и 4.36. 

 



 
Рис. 4.25. Модель к упражнению 2 

 

 
Рис. 4.26. Виды и размеры модели к упражнению 2 

 



Создание основания. Сначала необходимо создать основание путем поворота 

эскиза, созданного на плоскости Front (Фронтальная). 

1. Создайте новый документ в режиме Part (Деталь). 

2. Вызовите инструмент Revolved Boss/Base (Повернутая 

бобышка/основание) и начертите эскиз основания на плоскости Front 

(Фронтальная). Добавьте требуемые размеры и связи к эскизу (рис. 4.27). 

3. Выйдите из эскизной среды и создайте основание. Основание модели показано 

на рис. 4.28. 

 
    Рис. 4.27.Эскиз для базового элемента             Рис.4.28. Основание элемента 

 

Создание оболочечного элемента. После создания основания надо превратить 

его в оболочечный элемент, используя инструмент Shell (Оболочка). Кроме того, 

необходимо удалить нижнюю поверхность основания, чтобы модель получилась 

тонкостенной. 

1. Вызовите менеджер свойств Shell 1 (Оболочка1) и установите значение 

2,5 в счетчике Thickness (Толщина). 

2. Поверните модель и выделите нижнюю поверхность, чтобы ее удалить. 

3. Щелкните на кнопке ОК в менеджере свойств оболочки. Модель, полученная в 

результате добавления этого элемента, приведена на рис. 4.29. 

 

 
Рис. 4.29. Оболочечный элемент добавлен к модели . 

 



Создание третьего элемента. После добавления оболочечного элемента к 

модели нужно создать третий элемент методом вытягивания эскиза. Эскиз к этому 

элементу будет создан на плоскости Тор (Вид сверху). 

1. Вызовите инструмент Extruded Boss/Base (Вытянутая 

бобышка/основание) и выберите плоскость Тор (Вид сверху) для создания 

эскиза. 

2. Поверните модель в положение Тор (Вид сверху). 

3. Создайте эскиз третьего элемента и добавьте к нему требуемые связи и раз- 

меры, как показано на рис. 4.30. 

 

 
Рис. 4.30. Эскиз третьего элемента 

 

4. Выйдите из эскизной среды и вытяните эскиз на глубину 5 мм. 

 

Размножение третьего элемента.  

После создания третьего элемента модели нужно размножить этот элемент. Для 

этого следует использовать инструмент Circular Pattern (Круговой 

массив). Сначала нужно отобразить временные оси координат. Временная ось 

базового элемента будет выбрана в качестве центральной оси для создания круговой 

группы элементов. 

1. Выберите пункт меню View ► Temporary Axes (Вид ► Временные 

оси), чтобы отобразить временные оси. 

2. Вызовите менеджер свойств кругового массива и выберите временную ось 

базового элемента в качестве центральной оси. 

3. Выберите третий элемент, созданный ранее в области построений, если его нет 

в списке Features to pattern (Элементы для размножения). 



Предварительный вид создаваемой группы элементов будет отображен в области 

построений. 

4. Установите значение 5 в счетчике Number of Instances (Количество 

экземпляров) и щелкните на кнопке ОК в менеджере свойств кругового массива. 

5. Выберите пункт меню View ► Temporary Axes (Вид ► Временные 

оси), чтобы убрать временные оси с экрана. 

Модель после создания группы элементов показана на рис. 4.31. 

 

 
Рис. 4.31. Группа элементов добавлена к модели 

 

Редактирование группы элементов.  Как показывает рис. 4.25, созданная группа 

элементов не совсем удовлетворяет требованиям. Поэтому необходимо 

отредактировать эту группу элементов. 

1. Выберите элемент CirPatterni в дереве конструирования Feature 

Manager или выделите в области построений любой элемент массива, кроме 

родительского. Щелкните правой кнопкой мыши, чтобы вызвать контекстное меню, и 

выберите в нем пункт Edit feature (Редактировать элемент). На экране 

появится менеджер свойств для элемента CirPatterni. Ранее мы задали число 

экземпляров элементов в массиве, равное 5, но нам нужно только три копии. 

Отредактируем число экземпляров. 

2. Установите значение 3 в счетчике Number of Instances (Количество 

экземпляров) и щелкните на кнопке ОК. Модель после редактирования элементов 

показана на рис. 4.32. 



 
Рис. 4.32. Отредактированная группа элементов 

 

Гашение элементов. Как уже было сказано ранее, иногда требуется погасить 

некоторые элементы, чтобы снизить сложность модели. Погашенные элементы на 

самом деле не удаляются, они просто не выводятся на экран. Когда вы гасите элемент, 

его дочерние элементы тоже гасятся. 

Выберите элемент Extrude 1, который является третьим элементом модели, в 

дереве конструирования. Щелкните правой кнопкой мыши, чтобы вызвать 

контекстное меню, и выберите в нем пункт Suppress (Погасить). 

Круговая группа элементов является дочерним элементом по отношению к 

элементу вытягивания. Поэтому группа элементов тоже оказывается погашенной. 

Оба элемента не выводятся на экран в области построений. Значки элементов 

Extrude 1 и CirPatterni отображаются в дереве конструирования серым цветом. 

Это означает, что элементы погашены. 

Создание выреза. Далее нам предстоит сделать вырез в модели. Эскиз для этого 

элемента будет создан на верхней плоской грани базового элемента. 

1. Вызовите инструмент Extruded Cut (Вытянутый вырез) и выделите 

верхнюю плоскую поверхность базового элемента для размещения эскиза. 

2. Начертите эскиз выреза и добавьте к нему необходимые связи и размеры (рис. 

4.33). 



 
Рис. 4.33. Эскиз для выреза 

 

3. Выйдите из эскизной среды и выберите конечное условие Through All 

(Сквозь все) в менеджере свойств выреза. 

4. Щелкните на кнопке ОК в менеджере свойств выреза. 

5. Теперь, используя инструмент Linear Pattern (Линейный массив), 

создайте группу вырезов. Вы можете выбрать размер 18 для задания направления 

размножения. Модель, полученная после создания группы вырезов, приведена на рис. 

4.34. 

6. Создайте все остальные элементы модели. Размеры приведены на рис. 4.26. 

Модель, полученная после создания всех остальных элементов, изображена на рис. 

4.35. 

 

 
Рис. 4.34.модель для размножения вырезов     Рис.4.35. Модель после создания 

                                                                                             остальных элементов 



 

Восстановление погашенных элементов. После завершения модели нужно 

вернуть в модель элементы, которые мы погасили ранее. 

1. Нажмите клавишу Ctrl и, удерживая ее, выделите все погашенные элементы в 

дереве конструирования. 

2. Щелкните правой кнопкой мыши, чтобы вызвать контекстное меню, и 

выберите пункт меню Unsuppress (Высветить). Погашенные элементы будут 

восстановлены в модели. Готовая модель, полученная после восстановления всех 

погашенных элементов, приведена на рис. 4.36. 

 
Рис. 4.36. Готовая модель 

 

Примечание. Если вы выделите только родительский погашенный элемент и 

восстановите его отображение в модели, дочерние элементы этого элемента останутся 

погашенными. Поэтому следует выделять как родительские элементы, так и дочерние. 

Вместо того чтобы выделять все дочерние и родительские элементы в дереве 

конструирования, вы можете выделить только родительский элемент и выбрать пункт 

меню Edit ► Unsuppress with dependents ► All Configurations 
(Правка ► Высветить с зависимыми элементами► Все 

конфигурации).  

Если вы восстанавливаете дочерний элемент, то родительский элемент 

восстанавливается автоматически. 

Сохранение модели.  

1. Щелкните на кнопке Save (Сохранить) на панели инструментов 

Standard (Стандартная) и сохраните модель. 

2. Выберите пункт меню File ► Close (Файл ► Закрыть), чтобы закрыть 

документ. 

 



Задание.  Создайте модель, сечения которой приведены на рис. 4.37. Другие виды 

и размеры модели также даны на этом рисунке. Готовая модель приведена на рис. 

4.38.  

 
Рис. 4.37.  Виды и размеры модели к заданию. 

 



 
Рис. 4.38. Модель к заданию.  

  



Лабораторная работа № 5.  

 

Построение сборок в SolidWorks 

 

Цель работы – изучение методов компоновки сборок, построения сопряжений 

сборок в системе автоматизированного проектирования SolidWorks. 

 

Методические указания 

 

Сборкой называется документ, в котором детали и другие сборки сопряжены 

друг с другом в единую конструкцию. Сборку можно создавать, используя 

проектирование «снизу вверх», проектирование «сверху вниз» или комбинацию этих 

двух методов. 

 

Общие правила построения сборок 
 

Файл сборки в SolidWorks (расширение *.SLDASM) не содержит в себе описание 

геометрии деталей. Без полного комплекта составляющих деталей, сборок (узлов), 

типовых библиотечных элементов файл сборки является пустым объектом. 

Добавление компонента в сборку создает связь между ними. Изменения в компоненте 

сборки автоматически отражаются на сборке. 

В общем случае сборочное изделие представляет собой многоуровневую 

древовидную структуру. Файл сборки, как и реальное изделие, может включать не 

только отдельные детали, а также и другие сборки (узлы). Уровень вложенности при 

этом не ограничен. Сборка изделия в SolidWorks выполняется в соответствии с 

принципом технологической декомпозиции: составляющие изделие узлы могут 

собираться обособленно от других элементов конструкции. 

Реальный производственный процесс состоит из трех этапов: 

1. Установка базовой детали или сборочной единицы. 

2. Выбор и предварительная ориентация присоединяемой детали (сборочной 

единицы) относительно базовой. 

3. Выполнение сопряжений, соединение. 

Общий принцип создания сборочной модели по методу «снизу вверх» полностью 

соответствует указанному процессу сборки. Предварительно необходимо построить 

трехмерные модели деталей, а затем объединить их в единую конструкцию путем 

наложения ограничений на пространственное положение объектов. 

При проектировании «сверху вниз» трехмерные модели деталей 

разрабатываются в контексте одной сборки на основе геометрических элементов 

других деталей. В соответствии с данным методом первоначально создаваемая сборка 

является исходной информацией для выполнения последующей деталировки. 

Комплексное использование обоих методов позволяет вести разработку 

отдельных элементов конструкции (деталей, сборочных единиц) в контексте уже 

созданной сборки (состоящей из готовых компонентов). При таком подходе 

значительно облегчается задание привязок элементов друг к другу и обеспечивается 

параметрическая связь между ними. Если размеры или положение одной из деталей 

изменяются, то все связанные с ней элементы модели будут также автоматически 

скорректированы. 



Размещение компонентов в сборке 

 

Предварительно необходимо создать проект сборки в SolidWorks: меню Файл >> 

Новый >> Сборка. 

Основным способом размещения детали или узла в сборке является 

использование команды Вставить компоненты , расположенной на панели 

инструментов Сборки. После добавления к новому проекту первая деталь (сборка) 

автоматически приобретѐт свойство Зафиксированный (отображается значком «ф» в 

Дереве конструирования). 

Для правильной ориентации компонентов в сборке по крайней мере один из ее 

компонентов должен быть зафиксирован – относительно него будут располагаться 

остальные компоненты сборки (рис. 5.1). 

Чтобы зафиксировать или освободить компонент сборки, следует, выбрав 

компонент в графической области или в Дереве конструирования (FeatureManager), 

в контекстном меню (при нажатии правой кнопки мыши) активизировать команду 

Зафиксировать или Освободить. 

Также для компонентов в Дереве конструирования могут использоваться 

следующие префиксы: (–) недоопределен; (+) переопределен; (?) не решен. Отсутствие 

префикса означает, что положение компонента полностью определено. 

Дерево конструирования (FeatureManager) кроме традиционных элементов 

(наименования сборки, папки Примечание, начальных плоскостей и Исходной 

точки) для сборок отображает следующие объекты: 

– Компоненты сборки (узлы, отдельные детали, библиотечные элементы); 

– Папку Сопряжения; 

– Элементы сборки (вырезы или отверстия) и массивы компонентов. 

Любой компонент можно развернуть или свернуть, чтобы просмотреть его 

подробное описание, нажав на знак рядом с именем компонента. 

В сборке можно использовать один и тот же компонент несколько раз. При 

каждом добавлении в сборку компонента число <n> в окончании его имени в Дереве 

конструирования увеличивается на единицу. 

 
Рис. 5.1. Пример компоновки сборки розетки СРГ-50-731ФВ 



Для задания положения объекта в трехмерном пространстве реализованы 

команды Переместить компонент и Вращать компонент , которые располагаются 

на панели задач Сборки. Изменение положения для выбранного объекта производится 

при нажатии и удерживании левой кнопки мыши. Более простым и удобным способом 

свободного перемещения и вращения является способ с использованием манипулятора 

мыши: при «перетаскивании» мыши, удерживая левую кнопку, выполняется 

перемещение компонента, удерживая правую кнопку мыши – вращение компонента. 

Компоненты в сборке будут перемещаться или вращаться только в пределах степеней 

свободы, определенных сопряжениями (зафиксированные и полностью определенные 

объекты изменять своего положения не могут). 

 

Сопряжения 

 

После размещения деталей и узлов в сборке необходимо задать сопряжения 

между ними – геометрические взаимосвязи между компонентами сборки. При 

добавлении сопряжений следует определить допустимые направления линейного или 

вращательного движения компонентов. Последовательность, в которой добавляются 

сопряжения в группу, значения не имеет, все сопряжения решаются одновременно. 

Для создания сопряжений необходимо активизировать команду Условия 

сопряжения на панели инструментов Сборки, выбрать сопрягаемые поверхности 

деталей, указать тип сопряжения (рис. 5.2). 

 
Рис. 5.2. Пример задания сопряжения 

 

Системой поддерживаются следующие типы сопряжений. 

Совпадение – выбранные грани, плоскости и кромки (в комбинации друг с 

другом или с одной вершиной) разделяют одну и ту же бесконечную линию. 

Параллельность – выбранные элементы одинаково направлены и находятся на 

постоянном расстоянии. 



Перпендикулярность – выбранные элементы располагаются под углом 90º друг 

к другу. 

Касательность – выбранные элементы касаются (как минимум один элемент 

должен быть цилиндрическим, коническим или сферическим). 

Концентричность – выбранные элементы разделяют центральную точку. 

Расстояние – выбранные элементы расположены на указанном расстоянии. 

Угол – выбранные элементы расположены под заданным углом. 

Если в списке Выбор сопряжений присутствуют по крайней мере два 

наименования, то ниже во вкладке Стандартные сопряжения система автоматически 

предложит наиболее подходящие сопряжения для данного набора выделенных 

компонентов (см. рис. 5.2), а на экране появится панель инструментов, дублирующая 

эти элементы управления. 

Стандартные сопряжения применимы только для стандартных поверхностей 

(плоскость, цилиндр, конус и т.п.), а для более сложных требуется выравнивание 

относительно вспомогательной геометрии. 

Все заданные сопряжения сборки указываются в Дереве сопряжения в разделе 

Сопряжения. Наименование каждого сопряжения включает имена участвующих в 

нем компонентов, например: Концентрический1 (СРГ-50-731ФВ<1>, Стакан_СРГ-

50<1>). 

 
Упрощение сборок 

 

В реальности сборки могут состоять из большого числа компонентов. При этом 

программа тратит значительные ресурсы на поддержание трехмерной геометрии. Как 

следствие происходит замедление работы и замедление проектирования в целом. 

Упростить сложную сборку возможно переключением видимости и изменением 

состояния погашения компонентов, есть три возможных состояния компонентов: 

1. Решен – компонент целиком загружен в память, является полностью 

функциональным и доступным. 

2. Погашен – компонент не загружается в память и не является частью сборки (не 

отображается в графической области, сопряжения компонента также погашены). При 

этом компонент не удаляется из Дерева построения. 

3. Сокращенный – в память загружается некоторая часть данных о модели. 

Оставшиеся данные загружаются по мере необходимости. При этом компонент 

полностью доступен, все сопряжения, массовые характеристики сохраняются. 

Чтобы изменить состояние погашения компонентов следует в Дереве 

конструирования или в графической области правой кнопкой мыши выбрать нужный 

компонент и открыть вкладку Свойства компонента. Другой способ – активация 

инструмента Изменить состояния погашения для выбранного компонента на панели 

инструментов Сборки. 

Режим большой сборки – это комплект параметров системы, которые улучшают 

эффективность сборок. Режим большой сборки можно включить в любое время. 

Кроме того, можно установить пороговое значение количества компонентов, при 

достижении которого режим большой сборки будет включаться автоматически. 

  



 

Интерференция и конфликты между компонентами 

 

Одна из составляющих отработки изделия на технологичность – его проверка на 

собираемость: физические тела при их перемещении не могут иметь области 

пересечения. При использовании свойства 

Стандартное перетаскивание не учитывается интерференция объектов 

(возможна ситуация наложения объектов друг на друга). Для решения подобной 

задачи в SolidWorks реализованы два параметра в режиме перемещения и вращения 

компонентов (рис. 5.3, а). 

1. Определение конфликтов. Наиболее часто используемая функция данного 

параметра – ограничение движения выбранного объекта при первом касании с 

другими элементами сборки (если установлен флажок Остановить при конфликте). 

Этот параметр полезен при проверке возможности установки детали в сборку. 

2. Физическая динамика – позволяет увидеть реалистичное движение 

компонентов сборки. Все детали отождествляются с абсолютно упругими телами и 

при попытке смещения/поворота одного из них выполняется попытка повторить 

кинематику движений всего механизма, описанную множеством сопряжений (т.е. 

происходит перемещение или вращение всей цепочки затрагиваемых компонентов в 

пределах допустимых степеней свободы). Проверка наличия конфликтов может 

выполняться с интервалом 0,02 ... 20 мм (в единицах измерения модели), поэтому если 

установить максимальную чувствительность, процесс пересчета модели займет 

значительное время. 

 

 
Рис. 5.3. Инструменты определения конфликтов и интерференции 

 
В сложной сборке иногда трудно зрительно определить, где компоненты 

пересекаются друг с другом. С помощью инструмента Проверки интерференции 

можно определить и отобразить интерференцию между компонентами. После выбора 

параметров и настройки следует нажать кнопку вычислить. 



Обнаруженные интерференции перечислены в окне Результаты. Объем 

интерференции отображается справа от каждого списка. В простейшем случае 

пользователь имеет возможность выбрать соответствующую интерференцию, при 

этом в графической области она будет выделена красным цветом. 

 

Вид с разнесенными частями 

 

Для визуального анализа взаимосвязи компонентов сборки необходимо отделить 

их друг от друга. Вид сборки с разнесенными частями является вспомогательным и не 

позволяет добавлять сопряжения в сборку. 

Виды с разнесенными частями создаются путем выбора и перетаскивания деталей 

в графической области.  

Разнесенный вид сборки хранится вместе с конфигурацией сборки (третья 

вкладка Дерева построения). Чтобы создать разнесенный вид, необходимо 

активизировать команду Вид с разнесенными частями. В окне Настройка следует 

выбрать один или несколько компонентов, которые требуется внести в 

соответствующий шаг разнесения. В области Направление разнесения задается ось 

системы координат, в направлении которой выполняется разнесение (любой отрезок 

прямой линии, включая кромки и элементы эскизов). В области Расстояние 

разнесения указывается величина разнесения компонента. При необходимости 

направление разнесения компонента возможно поменять на противоположное – 

кнопка Реверс направления (рис. 5.4). 

 

 
Рис. 5.4. Создание вида с разнесенными частями 

  



 

Задание 

 

В этом упражнении вы создадите все компоненты верстачных тисков (Bench Vice) 

и затем соберете их. Сборка тисков показана на рис. 5.5. Размеры различных 

компонентов приведены на рис. 5.6-5.9. 

 
Рис. 5.5.  Сборка верстачных тисков. 

 

Для выполнения задания необходимо проделать следующее: 

1. Создайте все компоненты в отдельных документах деталей и сохраните их. 

Документы деталей будут сохранены в папке \Мои докyменты\SolidWorks\ Bench Vice. 

2. Откройте документы деталей Vice Body (Основание тисков) и Vice jaw (Губки 

тисков) и определите ссылки на сопряжения в обоих документах (рис. 5.10 и 5.11). 

3. Создайте новый документ сборки и откройте все документы деталей. 

Поместите в новый документ первый компонент, основание тисков, перетащив его из 

окна документа детали. Теперь перетащите губки тисков в документ сборки. Он 

автоматически будет собран с губками тисков, поскольку сопряжения уже были 

определены на рис. 5.12 и 5.13. 

4. Перетащите прижимной винт в документ сборки. Примените требуемые 

сопряжения в соответствии с рис. 5.14-5.20. 

5. Теперь проанализируйте степени свободы компонентов. 

6. После анализа сборки примените все ограничения для снятия всех степеней 

свободы в соответствии с рис. 5.21 и 5.22. 

7. Теперь соберите зажимную планку в соответствии с рис. 5.23-5.26. 

8. Установите фиксирующий винт с использованием сопряжений на основе 

элементов в соответствии с рис. 5.27. 

9. Аналогичным образом соберите остальные компоненты. 

 

 

 



 

 
Рис. 5.6. Виды и размеры основания тисков 

  



 
Рис. 5.7. Виды и размеры губок тисков 



 
Рис. 5.8. Виды и размеры зажимной планки, фиксирующего винта, винта 1 и винта 2 

  

 



 
Рис. 5.9. Виды и размеры подошвы, прижимного винта, ручки и ее наконечников 



Создание компонентов 

Создайте все компоненты тисков в отдельных документах деталей. Назовите 

документы в соответствии с рис. 5.6-5.9. Файлы должны быть сохранены в папке \Мои 

Докyменты\SolidWorks\ Bench Vice. 

 

Создание ссылок на сопряжения 

В этом упражнении вы соберете первые два компонента сборки с помощью 

ссылок на сопряжения. Для этого нужно сначала создать ссылки на сопряжения в 

документах деталей. 

1. Откройте диалоговое окно Open (Открыть). 

2. Дважды щелкните на значке Vice Body (основание тисков). Документ детали 

Vice Body (Основание тисков) откроется в окне SolidWorks. 

3. Выберите команду меню Insert ► Reference Geometry ► Mate 

Reference (Вставка ►Справочная геометрия ► Ссылка на 

сопряжение…). 

На экране появится менеджер свойств Mate Reference (Сопряжение 

элементов справочной геометрии). В раздвижной панели Primary 

Reference Entity (Объект ссылки первого уровня) активен режим 

выделения. 

4. Выделите плоскую поверхность, показанную на рис. 5.10, в качестве ссылки 

первого уровня. Выделенная поверхность будет подсвечена зеленым цветом. 

5. Выберите параметр Coincident (Совпадение) из списка Mate 

Reference Type (Тип ссылки на сопряжение) в раздвижной панели 

Primary Reference Entity (Объект ссылки первого уровня). Станет 

активен режим выделения в раздвижной панели Secondary Reference Entity 

(Объект ссылки второго уровня). 

6. Выделите плоскую поверхность, показанную на рис. 5.10, в качестве ссылки 

второго уровня. Выделенная поверхность будет подсвечена пурпурным цветом. 

 
Рис. 5.10 Поверхности, выбранные для сопряжения. 

 

7. Выберите параметр Coincident (Совпадение) из списка Mate 

Reference Type (Тип ссылки на сопряжение) в раздвижной панели 

Secondary Reference Entity (Объект ссылки второго уровня). 



Теперь активен режим выделения в раздвижной панели Tertiary Reference 

Entity (Объект ссылки третьего уровня). 

8. Выделите плоскую поверхность, показанную на рис. 5.10, в качестве ссылки 

третьего уровня. Выделенная поверхность будет подсвечена темно-красным цветом. 

9. Выберите параметр Parallel (Параллельность) из списка Mate 

Reference Type (Тип ссылки на сопряжение) в раздвижной панели 

Tertiary Reference Entity (Объект ссылки третьего уровня). 

10. Введите имя Vice Mate Reference в качестве названия ссылки на 

сопряжение в текстовое поле Mate Reference Name (Название ссылки на 

сопряжение) в раздвижной панели Reference Name (Имя ссылки). 

11. Щелкните на кнопке ОК в менеджере свойств Mate Reference 

(Сопряжение элементов справочной геометрии). 

12. Аналогичным образом образуйте ссылку на сопряжение в документе детали 

Vice Jaw (Губки тисков). Поверхности для выделения в качестве ссылок, 

приведены на рис. 5.11. Название ссылки на сопряжение в раздвижной панели 

Reference Name (Имя ссылки) должно быть одинаково в обеих частях 

документа. 

13. Закройте обе части документа, за исключением Vice Body.sldpart и 

Vice Jaw.sldprt. 

 
Рис. 5.11 Поверхности, выбранные для сопряжения. 

 

Размещение первых двух компонентов сборки 

После создания ссылок на сопряжения необходимо собрать компоненты. 

1. Создайте новый документ сборки SolidWorks. Менеджер свойств Insert 

Component (Вставить компонент) автоматически выводится на экран, и имена 

открытых компонентов отображаются в области выделения Open documents 

(Открытые документы). 

2. Выберите Vice Body в области выделения Open documents (Открытые 

документы); рядом с курсором компонента появится предварительный вид 

основания тисков. 

3. Щелкните на кнопке Keep Visible (He убирать) в менеджере свойств 

Insert Component (Вставить компонент), поскольку после размещения 



первого компонента, необходимо разместить второй компонент, который 

отображается в области выделения Open documents (Открытые документы). 

Рекомендуется, чтобы первый компонент сборки помещался в начало отсчета сборки. 

4. Щелкните на кнопке ОК в менеджере свойств Insert Component 

(Вставить компонент), чтобы разместить первый компонент в начале отсчета 

сборки. 

Поскольку кнопка Keep Visible (He убирать) нажата, изображение 

основания тисков появляется рядом с курсором в области чертежа. 

5. Измените текущий вид на изометрический. Теперь разместите второй 

компонент в сборке. Как говорилось ранее, второй компонент сборки, губки тисков, 

будет собран с основанием тисков с помощью ссылок на сопряжения. 

6. Выделите губки тисков в области выделения Insert Component 

(Вставить компонент). В области чертежа появится изображение губок тисков. 

Если теперь поместить курсор в документе сборки рядом с основанием, то 

изображение губок тисков собирается с основанием с помощью ссылок на 

сопряжения. 

7. Разместите компонент в нужном месте. Сопряжения, перечисленные в ссылках 

на сопряжения, будут применены для губок тисков и основания. Щелкните на кнопке 

Keep Visible (He убирать) и закройте менеджер свойств Mate 

(Сопряжение). 

На рис. 5.12 показан второй компонент, помещенный в документ сборки. На рис. 

5.13 показаны губки тисков вместе с основанием. 

 
Рис. 5.12 Перетаскивание второго компонента. 

 



 
Рис. 5.13. Губки тисков в сборе с основанием. 

 

8. Закройте окна всех документов деталей, которые помещены в документ сборки. 

Совет. Сопряжения, которые определены в ссылках на сопряжения, применяются 

к компонентам при их размещении в сборке. Для просмотра сопряжений, 

применяемых к обоим компонентам, нужно развернуть параметр Mates 

(Сопряжения) в дереве конструирования FeatureManager Design Tree в 

документе сборки. 

 

Установка прижимного винта 

Теперь необходимо разместить прижимной винт в документе сборки. 

1. Щелкните на кнопке Insert Component (Вставить компонент) в 

менеджере команд Assemblies (Сборки). 

2. Щелкните на кнопке Browse (Обзор) в раздвижной панели 

Part/Assembly to Insert (Деталь/Сборка для вставки). На экране 

появится диалоговое окно Open (Открыть). 

3. Дважды щелкните на прижимном винте, чтобы открыть для него документ 

детали. В области чертежа появится изображение прижимного винта. 

4. Щелкните в любом месте чертежа, чтобы разместить прижимной винт. На рис. 

5.14 показан прижимной винт, размещенный в произвольном месте документа сборки. 

Теперь нужно добавить сборочные сопряжения, чтобы собрать все компоненты. 

 



 
Рис. 5.14 Прижимной винт размещен в документе        Рис. 5.15. Поверхность для  

                 cборки                                                                             создания сопряжения 

 

5. Удерживайте нажатой клавишу Alt. Выделите поверхность для размещения, 

как показано па рис. 5.15. 

6. Удерживая прижимной винт вблизи низшего края, перетащите его в 

направлении отверстия в основании, как показано на рис. 5.16. При этом на экране 

будет отображаться предварительный вид прижимного винта, а курсор выделения 

поменяется на курсор автоматического сопряжения. Рядом с курсором появится 

символ сопряжения концентричности. 

7. В этот момент отпустите левую кнопку мыши. На экране появится панель 

инструментов Mate (Сопряжение), на которой по умолчанию нажата кнопка 

Concentric (Концентричность). Это означает, что в данном случае наиболее 

подходящим является сопряжение Concentric (Концентричность). Щелкните 

на кнопке Add/Finish Mate (Добавить/Завершить сопряжение) на 

панели инструментов Mate (Сопряжение). На рис. 5.17 показан прижимной винт в 

сборе с основанием. 

 

 
Рис. 5.16 Перетаскивание прижимного             Рис. 5.17. К прижимному винту и  

        винта                                                               основанию применено сопряжение    
                                                                                                            Коцентричность 

 

Далее необходимо применить сопряжения совпадения между плоскими 

поверхностями прижимного винта и губок тисков. 



8. Щелкните на кнопке Mate (Сопряжение) в менеджере команд 

Assemblies (Сборки), чтобы вывести па экран менеджер свойств Mate 

(Сопряжение). 

9. Поверните вид сборки и выделите поверхность губок тисков (рис. 5.18). Затем 

выделите поверхность прижимного винта (рис. 5.19). 

 

 
Рис.5. 18  Поверхность для выделения         Рис. 5.19.  Поверхность для создания  

                                                                                        сопряжения 

 

При выделении поверхностей на экране появляется панель инструментов Mate 

(Сопряжение). Кроме того, в области чертежа отображается сборка с сопряжениями 

совпадения. 

10. Щелкните на кнопке Add/Finish Mate (Добавить/Завершить 

сопряжение) на панели инструментов Mate (Сопряжение). Сборка после 

добавления сопряжения Coincident (Совпадение) показана на рис. 5.20. 

 
Рис.5.20  Сборка после применения сопряжения Coincident (Совпадение) к 

прижимному винту 

 

В реальном мире существуют сборки двух типов. Первый тип – полностью 

определенная сборка, в которой зафиксированы все степени свободы. Другой тип – это 

сборки, в которых некоторые степени свободы оставлены незафиксированными, так 

что некоторые компоненты можно перемещать или вращать. Эти типы сборок 

используются для механизмов. 



После добавления сопряжения Coincident (Совпадение) необходимо 

привести сборку в движение, чтобы выяснить степени свободы ее компонентов. После 

анализа компонентов сборки для снятия этих степеней свободы потребуется 

добавление сопряжений. 

11. Выделите круглую грань прижимного винта с помощью левой кнопки мыши и 

перетащите курсор. Вы увидите, что прижимной винт вращается на свой оси и 

перемещается вдоль оси X. Кроме того, губки тисков перемещаются вдоль оси X. 

Изначально эта степень свободы губок тисков и прижимного винта должна оставаться, 

чтобы сборка могла работать. Однако в данном упражнении следует закрепить эту 

степень свободы, чтобы создать полностью определенную сборку. 

12. Выделите две поверхности: одну на основании, а другую на прижимном винте 

(рис. 5.21 и 5.22). 

13. Щелкните на кнопке Distance (Расстояние) в раздвижной панели 

Standard Mates (Стандартные сопряжения) и установите значение 10 в 

счетчике Distance (Расстояние). После этого название менеджера свойств 

поменяется на Distance 1 (Расстояние 1). 

14. Щелкните на кнопке ОК в менеджере свойств Distance 1 (Расстояние 

1). На экране опять появится менеджер свойств Mate (Сопряжение). 

 
Рис.5.21  Поверхность, выделяемая                      Рис. 5. 22. Поверхность, выделяемая 

сопряжения                                                                                на прижимном винте 

 

15. Разверните дерево конструирования FeatureManager в области чертежа и 

выделите плоскость сборки Тор (Вид сверху). Теперь выберите прижимной винт 

в дереве конструирования FeatureManager, а затем – плоскость Тор (Вид 

сверху). На экране отобразится панель инструментов Mate (Сопряжение). 

16. Щелкните на кнопке Angle (Угол) на панели инструментов Mate 

(Сопряжение). 

17. Установите значение 45 в счетчике Angle (Угол). Щелкните на кнопке 

Add/ Finish Mate (Добавить/Завершить сопряжение) на панели 

инструментов Mate (Сопряжение). 

18. Щелкните на кнопке ОК в менеджере свойств Mate (Сопряжение).  

  



 

Установка зажимной планки 

Теперь вам нужно собрать зажимную планку. 

1. Откройте менеджер свойств Insert Component (Вставка 

компонентов) и щелкните на кнопке Browse (Обзор), чтобы вывести на экран 

диалоговое окно Open (Открыть). Поместите зажимную планку в область чертежа. 

2. Поверните сборку так, чтобы нижняя поверхность сборки была видна, как 

показано на рис. 5.23. 

3. Выделите зажимную планку правой кнопкой мыши и перетащите курсор, чтобы 

повернуть зажимную планку (рис. 5.24). 

 
    Рис.5.23.  Сборка после вращения                     Рис. 5.24. Зажимная планка  после   

                                                                                                    поворота 

 

4. Примените сопряжения Concentric (Концентричность) между двумя 

цилиндрическими поверхностями на зажимной планке и двумя отверстиями на губках 

тисков в соответствии с рис. 5.25. Возможно, вам придется переместить зажимную 

планку после применения первого сопряжения. 

5. Перетащите зажимную планку. Теперь примените сопряжение Coincident 

(Совпадение) между поверхностями зажимной планки и губок тисков (рис. 5.26). 

6. Аналогичным образом установите ручку и ее наконечники. Окончательный вид 

сборки показан на рис. 5.27. 

 
Рис. 5.25. Поверхности для создания сопряжения 

 



 
Рис. 5.26. Поверхности для создания сопряжения 

 

 
Рис. 5.27 Сборка после добавления основания, губок тисков, прижимного винта, 

ручки, зажимной планки, подошвы и наконечников ручки 

 

Сборка оставшихся компонентов 

Теперь вам нужно установить фиксирующий винт, винт 1 и винт 2. Этот крепеж 

собирается с помощью сопряжений на основе элементов. 

1. Откройте документы деталей Oval Fillisters (Фиксирующий винт), 

Set Screw 1 (Винт 1) и Set Screw 2 (Винт 2). 

2. Выберите команду меню Window ► Tile Horizontally (Окно ► 

Разместить по горизонтали). 

3. Выделите элемент Revolvel в дереве конструирования FeatureManager 

для документа детали Oval Fillisters (Фиксирующий винт). Перетащите 

компонент в сборку (рис. 5.28). 

4. Отпустите кнопку мыши, когда рядом с курсором появится символ совпадения. 

Аналогичным образом соберите винт 1 и винт 2 с помощью сопряжений на 

основе элементов. Для изменения направления используйте клавишу Tab. 

Сборка после добавления винта 1 и винта 2 и поворота показана на рис. 5.29. 

 



 
Рис. 5.28. Перетаскивание фиксирующего винта в сборку  с использованием 

сопряжений на основе элементов 

 

4. Отпустите кнопку мыши, когда рядом с курсором появится символ совпадения. 

Аналогичным образом соберите винт 1 и винт 2 с помощью сопряжений на основе 

элементов. Для изменения направления используйте клавишу Tab. 

Сборка после добавления винта 1 и винта 2 и поворота показана на рис. 5.29. 

 

 
Рис. 5.29. Финальный вид сборки снизу 

 

5. Щелкните на кнопке Save (Сохранить), чтобы сохранить сборку под именем 

Bench Vice. 
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